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■ Notices about using this User's Manual
In order to properly use this product, please carefully read this manual before using. 
T&D Corporation accepts no responsibility for any malfunction of and/or trouble with this 
product or with your computer that is caused by the improper handling of this product 
and will deem such trouble or malfunction as falling outside the conditions for free repair 
outlined in the attached warranty.

- All rights of this User's Manual belong to T&D Corporation. It is prohibited to use, 
duplicate and/or arrange a part or whole of this User's Manual without the permission of 
T&D Corporation. 

- Microsoft and Windows are registered trademarks of Microsoft Corporation USA and are 
binding in the USA and all other countries.  
Windows Vista is either a registered trademark or trademark of Microsoft Corporation in 
the United States and/or other countries.  

- All registered trademarks, company names, product names and logos mentioned herein 
are the property of T&D Corporation or of their respective owners. 

- Specifications, design and other contents outlined in this manual are subject to change 
without notice.

- On screen messages in this manual may vary slightly from the actual messages. 
Please notify the shop where you purchased this product or T&D Corporation of any 
mistakes, errors or unclear explanations in this manual. 
T&D Corporation accepts no responsibility for any damage or loss of income caused by 
the use of our product. 

- This product has been designed for private or industrial use only.It is not for use in 
situations where strict safety precautions are necessary such as in connection with 
medical equipment, whether directly or indirectly. 

- We are not responsible for any malfunction or trouble caused by the use of our product 
or by any problem caused by the use of measurement results of our unit. Please be fully 
aware of this before using our product. 

- This User's Manual cannot be reissued, so please keep it in a safe place.
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Software User's Agreement 

■ Disclaimers
- T&D Corporation does not guarantee the operation of RTR-5W for Windows.

- T&D Corporation shall not accept any responsibility for any damage whether direct or 
indirect that results from the usage of RTR-5W for Windows.

- Specifications of RTR-5W for Windows may be subject to change and service may be 
terminated without advance notice to the user. In such a case, T&D Corporation shall 
not be responsible for any damages, whether direct or indirect, from the inability to use 
RTR-5W for Windows.

- T&D Corporation has no obligation to correct any defects found in RTR-5W for 
Windows.

■ Copyright
- All copyrights for RTR-5W for Windows, including all of the programs and all related 

documents, are the sole property of T&D Corporation.

- The reprinting or redistribution for commercial purposes whether in part or in whole, 
in magazines or as a part of any product is strictly forbidden without the expressed 
consent of T&D Corporation. Any inquires concerning commercial redistribution should 
be directed to the Sales Department of T&D Corporation.

- Please do not attempt to make any changes or modifications to RTR-5W for Windows.

*RTR-5W consists of the following applications: RTR-5W for Windows, Network Settings 
Utility, Temperature / Humidity Graph, Multi-Scale Graph, Event Viewer and RTR-5W 
web Viewer. 
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Safety Precautions and Instructions

To ensure safety be sure to obey all of the following warnings.
The following items should be strictly obeyed for the safe usage of this unit, and for 
protecting yourself and other people from bodily harm and/or damage to property. Before 
using make sure to carefully read, understand and follow the safety rules and precautions 
for our products as outlined below.

■ Explanation of Symbols

Explanation of Warning Symbols

Warning
These entries are actions that absolutely under no circumstance should 
be taken. The taking of such an action may cause serious personal 
physical damage or death.

Caution
These entries are actions that if taken may lead to physical injury or 
damage to persons or things.

Explanation of Picture Symbols

Denotes an important warning or caution. Inside or near the symbol will 
appear another symbol giving details.

Denotes a forbidden action. Inside or near the symbol will appear another 
symbol giving details.

Denotes an action that you must take. Inside or near the symbol will 
appear another symbol giving details. (Ex: Unplug power plug from outlet)
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 Warning
Do not take apart, repair or modify the main unit. 
This may cause fire or electrocution.

When installing and using this product, make sure to follow all warnings and 
directions from your computer manufacturer. 
Be careful of igniting fire.

If water or a foreign body enters into this unit, immediately unplug the AC adaptor 
and stop using.
Continued use may cause fire or electrocution.

Do not use this unit in wet or humid places, such as a bathroom.
It may cause a fire or other trouble including malfunction.

Store main units, AC adaptors, and LAN cables out of the reach of children.
Touching them may result in injury and it is dangerous if they are dropped.

If any smoke or strange smells are emitted from the unit, immediately pull out the 
AC adaptor and cease using it.
Continued use may cause fire or electrocution.

Do not drop the unit, or expose the unit to a strong impact. If that happens, 
immediately unplug the AC adaptor and stop using it.
Continued use may cause fire or electrocution.

Make sure to periodically remove dust and dirt from the AC adaptor plug.
If dust is allowed to accumulate on the plug, moisture may cause poor insulation 
and result in fire.

Do not unplug the AC adaptor with wet hands.
This may cause electrocution.
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We are not responsible for any damage, malfunction or trouble, whether direct 
or indirect, caused by the use of our product. Please be fully aware of this before 
using our product.

This product has been designed for private or industrial use only. It is not for use 
in situations where strict safety precautions are necessary such as in connection 
with medical equipment, whether directly or indirectly.

This unit is not waterproof.
If the unit gets dirty, wipe it with a clean cloth dipped in alcohol.

Harmful gases or chemicals may cause corrosion and/or other danger to the 
unit. Also, by coming in contact with hazardous substances, harm may occur to 
the people handling the unit. Therefore, do not use in any environment that is 
exposed to chemicals and harmful gases. 

Make sure that the LAN cable and AC adaptor are inserted fully, so as not to 
cause an improper connection.

Also, when unplugging the LAN cable from the main unit, do not pull the cord, but 
hold the connector to disconnect.

Condensation may occur if the unit is moved from one environment to another 
where the difference in temperature is great. Use the unit in an environment 
where the ambient temperature is from 0 to 50ºC and the humidity is between 
20% and 80% RH (no condensation).
If you are using a Wireless LAN card, please follow all instructions included with 
the card. 

Please do not insert your fingers or any foreign objects into the connection jacks.

To prevent damage to the unit from static electricity, remove static electricity 
from your body by touching metal around you (door knob, window frame) before 
touching the unit.
Static electricity may cause not only damage to the unit, but may cause breaks in 
or a loss of data.

Do not put anything on top of the AC adaptor. 
This may cause overheating.

 Caution
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Do not use or store the unit in places such as listed below:
Doing so may cause electrocution, fire and/or other adverse effects to the device 
and/or your computer.
- Areas exposed to direct sunlight 

This will cause the inside of the device to become overheated and may cause 
fire, deformation, and/or other damage including malfunction.

- Areas prone to strong magnetic fields 
This may cause damage including malfunction.

- Areas exposed to water leakage 
This may cause electrocution or other damage including malfunction.

- Areas exposed to excessive vibration 
This may cause injury, malfunction, damage or loss of proper electrical contact.

-Areas that are not flat or level  
This may cause the unit to fall and result in injury and/or damage. 

-Areas near fire or exposed to excessive heat 
This may cause damage including malfunction and deformation.

-Areas prone to smoke, dust and dirt 
This may cause damage including malfunction.

 Wireless Regulations

This device complies with part 15 of the Federal Communications Commission (FCC) 
rules. Operation is subject to the following conditions: 

(1) This device may not cause harmful interference, and
(2) This device must accept any interference received, including interference that may 

cause undesired operation.
Note:
This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. 
This equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense.

Changes or modifications not expressly approved by the party responsible for 
compliance could void the user's authority to operate the equipment.

This device complies with RSS-210 of the Industry Canada (IC). Operation is subject to the 
following two conditions: 
(1) this device may not cause interference, and (2) this device must accept any interference, including 
interference that may cause undesired operation of the device.
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What is Web Wing WL RTR-5W?

The RTR-5W not only serves as a base station for the wireless downloading of recorded 
data from our compact waterproof Wireless Communication RTR-5 Series Data Loggers, 
but, moreover, the Web Wing WL RTR-5W serves as a network base station that allows 
you to monitor and view current readings and gather recorded data via LAN or Internet 
connection. 

■ Examples of Usage
- Recording measurements taken from various measuring instruments such as flow 

meters, power meters, and analyzers.

- Data recording of moving objects and rotating objects on a production line. 

- Temperature and humidity management in high humidity environments such as brewing 
and crop cultivation.

- Measurement in places where wiring is difficult or impossible. 

* The RTR-5W is designed solely for network communication. It does not include any RS-232 or USB communication interface. To make 
use of this product you must connect it to a network. Moreover, in order to use this product via the Internet you will need other devices 
(such as a router) and must first make necessary arrangements with a provider for a line and get a fixed IP address, domain, etc. 

* When making settings in an RTR-5W without any settings already made (when purchased or after resetting), it is necessary to carry 
out these settings using a wired LAN connection. After having made all the necessary settings via the wired connection, it is possible to 
use a wireless LAN connection.
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■ Basic Functions
Gathering and Managing Remote Unit Data via a Network 

The RTR-5W is able to gather via wireless communication the measured and recorded data from 
any RTR-5 Series Data Logger and using a Local Area Network (LAN) or Internet connection 
makes it possible to view current readings and / or download the gathered recorded data. 

Extending Wireless Communication Range with RTR-50

By setting up RTR-50 Unit(s) as Repeaters it is possible to extend the wireless communication 
range. 
Up to 250 Repeaters can be set up.

With the Internal Web Server, use a browser to check current readings and view in 
simple graph form

Because the RTR-5W is designed with a built-in Web server, it can be accessed directly from 
your Internet browser.Via the browser you can check the current readings of any Remote Unit 
that has been registered and view the recorded data in the Remote in a simplified graph form. 

Connect to a Wireless LAN via CF Card

The RTR-5W is designed with a CF card slot. By inserting a wireless LAN card in this CF card 
slot, it is possible to connect to a Wireless LAN; releasing you from the burden of cables and 
wiring.
*For more about Wireless LAN connections please refer to: FAQ's >> Q&A about RTR-5W >> Q.6 
“I want to use a wireless LAN… "(p.137)

     Internet Connection allows for Public Access to Data

The built-in Web server gives you the option of putting your data on the Internet for public 
access. 
Also by using the Internet connection you can escape the boundaries of the Local Area Network 
and gain the freedom to manage and collect data from anywhere the Internet is available; a low-
cost alternative  to having to be in the local area. 

View Current Readings via Cell Phone

It is also possible to use your cell phone browser to view current readings.

Set Upper / Lower Limits and Send Warning Report E-Mail

By making upper and lower limit settings for the RTR-5W, when one of the set upper or lower 
limits has been exceeded, a warning report mail can be sent via e-mail. 
* To make use of the warning report e-mail send function, it is necessary to be create an environment in 
order to connect to the Internet or to an in-company (in-house) SMTP/POP server. 

When a warning occurs it is possible to use contact output

When a set upper or lower limit has been exceeded, it is possible not only to send a warning 
report via e-mail, but it is also possible to use the provided contact output on the main unit to 
issue a warning within a structured warning system. 
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■ Basic Functions of RTR-5W for Windows
The software is made up of the following 5 applications: [Network Settings Utility], [RTR-
5W for Windows], [Temperature / Humidity Graph], [Multi-Scale Graph] and [Event Viewer]. 
Also, by using your web browser to access RTR-5W, it is possible to view data via the 
Internet.

*Only compatible with Internet Explorer 6.0 or higher using Windows 2000/XP/Vista/7.

Network Settings Utility
Make the necessary network settings for RTR-5W.

- Network Initialization Settings
Settings for helping to connect the RTR-5W to a network.

- Detailed Network Settings
Make detailed Network settings here.

RTR-5W for Windows
Make all necessary settings in order to communicate with RTR-51/52/52Pt/53, RVR-52A 
Data Loggers via the RTR-5W Base Station. For each RTR-5W it is possible to create one 
tree, and in that tree register Remote Units for communication. 

- Remote Registration
Register any logger in the RTR-5 Series as a Remote Unit; also possible to register in Groups 
for easy management. 

- Recording Settings
By setting the recording interval, the recording start time and the recording mode, recording will 
begin at the set date and time. 

*When using RTR-52Pt make sure to make all necessary sensor settings.

- Downloading Recorded Data
Download recorded data from the RTR-5W to a computer and create files.
Also, by making Auto-Download settings, it is possible to gather from Remote Units at a set 
interval of time or at a set time of day. 

- Warning Monitoring
If a measurement exceeds the set limit, a notification can be sent via e-mail from the RTR-5W 
to your computer or cellular phone. Also, because there is a built-in external output terminal, it 
is possible to connect to an external device, such an alarm or light, so that a notification of a 
warning can be seen or heard onsite. 

- Gathering Current Data
Gather and view current measurement readings from the selected Remote Unit(s). 

- Transfer Data
The RTR-5W retrieves and stores data at a set regular interval. This stored data is transferred 
for display. 



4

Temperature / Humidity Graph / Multi-Scale Graph
Temperature and Humidity are displayed in the Temperature and Humidity Graph. In the 
Multi-Scale Graph, voltage, pulse, temperature and humidity data can be viewed in graph 
form. 
In Multi-Scale Graph, it is possible to make settings for scale and unit of measurement to 
match the type of data being downloaded. 

- View Graphs and Print

It is possible to view the downloaded data as a list and print. 

■ View 8 channels of data in 1 display 
Up to 8 channels of recorded data can be viewed in the same graph at one time.

■ Easy zoom in and out with mouse 
By selecting a range with your mouse you can easily zoom in and out on data. 

■ Calculate and view the highest, lowest and average readings for a desired range 
In the Graph, for each channel it is possible to designate a desired range from which the 
highest, lowest and average readings will be calculated and displayed. 

■ Graph Printing 
It is possible to easily print in color the Graph as it is being displayed.

- View and Print Data List

You can view the data displayed in the graph window as a list and then choose to print.

■ View in Easy to Distinguish Colors 
In the data list, the highest value will appear in red, the lowest in blue, and the average in pink.

■ Printing the Data List 
It is possible to print the entire list as displayed or to select pages for printing.

- Creating Text File

It is possible to convert the recorded data for a specified range (time period) into a file using 
a common text format (such as CSV format), so that it can be exported to commercial 
spreadsheet and analysis software.

Event Viewer
View and print Event data recorded with the RVR-52A Data Logger.

- View List

Up to 64 channels of downloaded data can be viewed in one list. 

- Print Preview and Print

Printing can be carried out after checking the preview window. 

- Creating Text File

It is possible to convert the recorded data for a specified range (time period) into a file using 
a common text format (such as CSV format), so that it can be exported to commercial 
spreadsheet and analysis software.
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RTR-5W Web Viewer
Use your browser to monitor current readings and view data graphs. 

- Monitor Current Readings

The RTR-5W communicates with Remote Units at a set regular interval and then stores the 
gathered readings. The most recent measurement will be displayed. 
It is also possible to view via a cell phone browser. 

- Graph

The graph displayed in the browser will be the same graph that is shown upon opening [Transfer 
Data] in RTR-5W for Windows.
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Package Contents

The following items are included in the package:

LAN Cable LN-20W x 1

Web Wing WL RTR-5W  
x 1 unit

Software CD-ROM x 1

Introductory Manual and 
Warranty x 1
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RTR-5W Part Names and Functions

■ Part Names

FRONT

Optical Communication Area

POWER

Alarm

Monitor

POWER LED While the power is ON, the lamp will be on.

Alarm LED When a warning occurs, the lamp will blink.

Monitor LED
While wireless communication is occurring with a Remote Unit, 
the lamp will blink.

Optical Communication 
Area

When you wish to communicate directly, not by wireless, with a 
data logger (Remote Unit), it is necessary to place the logger 
(Remote Unit) face down on this area for communication to occur. 

Bottom

External Output Terminal 

External Output 
Terminal 

Connect to an alarm buzzer or light to notify locally of the occurrence 
of a warning. 
(Conditions for Output to be switched ON)
It switches to ON when a warning is received from at least one Remote 
Unit. 
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RIGHT SIDE

Reset Button

CF interface slot

LEFT SIDE

AC Adaptor Jack

Ethernet Jack

Ethernet Jack
10Base-T/100Base-TX Ethernet Connector
 Connect with LAN Cable.

AC Adaptor Jack Connect using the supplied AC adaptor

CF Interface Slot

Insert a Wireless LAN Card. *1

NOTE: 
Do not insert or try to connect anything other than a CF communication card.

RESET Button Press to return to the factory default settings.

*For more about Wireless LAN connections please refer to: FAQ's >> Q&A about RTR-5W >> Q.6 
“I want to use a wireless LAN… "(p.137)



9

Before Using... *When using an RTR-50 as a Repeater 

Thank you for purchasing this product. 
Please be careful about the procedures for Installation. 
(For USB communication between your computer and an RTR-50) 
The application and USB device driver must be installed for USB communication between 
your computer and an RTR-50. 
Before connecting an RTR-50, make sure to install the application and USB device 
driver into your computer. If you connect an RTR-50 to the computer before 
installing, the USB device driver may not be installed properly.  
If you have connected an RTR-50 to your computer before installing the USB device 
driver, make sure to click the [Cancel] button in the Wizard window when it pops up on the 
computer display. Then disconnect the USB cable from the RTR-50. 
For derails about the USB driver installation, see the [Repeater Registration] – [Installing 
the USB Device Driver] (p.51). 
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Outline of Use

■ Basic Operation

Getting Ready

1. Prepare the Data Loggers you wish to use as Remote Units

Get the units ready for measuring by connecting the proper sensors and installing the proper 
batteries.

2. Getting the RTR-5W Ready to Use

Get the unit ready for communication by connecting the network cable and AC adaptor. 

*To use as a Repeater, it is first necessary to prepare the RTR-50 as a Repeater.

3. Checking your Operating Environment

You also need to check your computer and network setup and be sure to prepare any 
necessary devices like routers to enable connection to your access point

4. Connecting to a Network

Connect the RTR-5W to the desired network.
See p.20-21 for connection examples of how to connect directly to your computer or use a 
router.

*Even if you are planning to use a wireless LAN, it is necessary to make the initial settings via 
a wired connection. 

5. Install RTR-5W for Windows

To enable set up, install the supplied software RTR-5W for Windows into your computer.
By installing RTR-5W, all of the following applications will be installed: [RTR-5W for Windows] 
for setting up Remote Units, making recording settings and other operational settings, [Network 
Settings Utility] for making network settings, and [Temperature / Humidity Graph], [Multi-Scale 
Graph], [Event Viewer] for viewing various types of recorded data. 
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Initialization Settings

1. Network Initialization Settings... from the Network Settings Utility

To connect to a network, it is necessary to enter an IP address and Subnet Mask that are 
appropriate for your network. Under Network Initialization Settings make the appropriate 
settings for your [IP address] and [Subnet Mask]. More detailed settings can be made in [Detailed 
Network Settings].

2. Remote Unit Registration... from RTR-5W for Windows 

In order to carry out wireless communication between an RTR-5W base station and a Remote 
Unit, please register Data Loggers as Remote Units as follows.
1. Create a Location  
2. Create Group(s)  
3. Register Remote Unit(s)
4. Depending on the communication status, register and position a Repeater

*Up to 64 Remote Units can be registered to one Location. 

Basic Operations

1. Recording Settings... from RTR-5W for Windows 

By setting the Recording Interval, the Recording Start Date / Time and the Recording Mode, 
recording will begin at the set date and time. 

*When using RTR-52Pt make sure to make any necessary sensor settings.

2. Download Data... from RTR-5W for Windows 

Data recorded in the Remote Unit will be downloaded and saved in your computer as a data 
file. Downloaded temperature and humidity data can be viewed in [Temp / Humidity Graph], 
downloaded Voltage, Pulse and Temp / Humidity data can be viewed in [Multi-scale Graph] and 
downloaded Event data can be viewed using [Event Viewer]. 
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Graph Display

Temp / Humidity Graph 

Temperature and Humidity data can be displayed in the same Temperature / Humidity Graph (Up 
to 8 channels of data).
You can view the data displayed in the graph window as a list and also choose to print. It is also 
possible to convert the data to common text file format (CSV type format). 

Multi-scale Graph

In the Multi-Scale Graph, voltage, pulse, temperature and humidity data can be viewed in the 
same Graph (Up to 8 channels of data).
You can view the data displayed in the graph window as a list also choose to print. It is also 
possible to convert the data to common text file format (CSV type format). 

Event Viewer

The Event Viewer allows you to add and view up to 64 channels of downloaded Event Time 
data recorded with the RVR-52A. 
Select the channels of data you wish to print from the channels displayed in the Event Viewer; 
view them in the Print Preview, and print (Up to 4 channels can be selected at one time).
It is also possible to convert the data to common text file format (CSV type format). 
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Other Functions

Warning Monitoring Settings... from RTR-5W for Windows 

Monitoring at each Location for warnings is carried out and if any of the gathered data exceeds 
the set limit, a notification can be sent via e-mail to your computer or cellular phone. Also, 
because there is a built-in external output terminal, it is possible to connect to an external 
device, such an alarm or light, so that a notification of a warning can be seen or heard on site. 
If the RTR-5W is not connected to the Internet, warning report e-mail cannot be sent.

Auto Download Settings... from RTR-5W for Windows 

The downloading of data can be set to be automatically carried out at a specified time or at a 
set interval of time. 
For Auto download to occur at a set time, it is necessary for RTR-5W for Windows to be open. 

Gather Current Data... from RTR-5W for Windows 

RTR-5W communicates with Remote Units to gather and display the current measurement 
readings. Also, by setting a communication interval, the current readings will be continuously 
gathered and displayed at that interval. 
If you are using RVR-52A to record Pulse Data, the current reading will be displayed as the 
average of recorded readings during the set recording interval. If you are recording the time of 
an Event, the current reading will show HI or LO (Rising Edge or Falling Edge).

Transfer Data... from RTR-5W for Windows 

The RTR-5W retrieves and stores data at a regular interval set in [Location (RTR-5W) 
Properties]. This stored data is transferred and displayed for each Remote Unit. 

* Event Data recorded with RVR-52A cannot be viewed in this manner.

Monitor Current Readings... RTR-5W Web Viewer

The RTR-5W retrieves and stores data at a regular interval set in [Location (RTR-5W) 
Properties]. The most recent measurement reading(s) can be viewed in the browser. 

Graph... RTR-5W Web Viewer

The graph displayed in the browser will be the same graph that is shown upon opening [Transfer 
Data] in RTR-5W for Windows.
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■ Software Operations Table

RTR-5W for Windows

R
T

R
-5W

 for W
indow

s

[File]
menu

Open Temp/Humidity Graph
Open Multi-scale Graph
Open Event Viewer
Text Data Output Settings
Read Data Collector Registration Info File
Output Registration Info File for Data Collector 

[View]
menu

Expand to Whole Tree
Programmed Auto Download
View Log
Store in Task Tray
Display Format Settings

[Registration / 
Administration]

menu

Create Locations / Properties
Create Groups / Properties
Remote Unit Registration / Properties / Initialization
Repeater Registration
Delete from Tree

[Settings]
menu

Start / Stop Recording
Start / Stop Warning 
Battery Life Warning Settings
Mail Settings for Download 
Send Group / Remote Info
RTR-52Pt Sensor Settings (Optical Communication)
Adjustment Settings (Optical Communication) 
Moisture Probe Settings (Optical Communication)
Script Update

[Data]
menu

Download Data
Download Data (Optical Communication)
Gather Current Data... 
Transfer Data... 
View Remote Unit Battery Level
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Network Settings Utility

N
etw

ork S
ettings U

tility

Network
Initialization 

Settings

IP Address
Subnet Mask

Network
Detailed 
Settings

Login ID
Password
DNS
SNTP
SMTP Mail Server
IP Block
Wireless LAN
Port Number
Time Difference
Mail Auth Settings
Rebooting the Communication Functions 
(Restarting the System)

[Menu]
Menu

Login History – ON / OFF
Clear Login History
Communication Time Settings

RTR-5W Web Viewer
W

eb V
iew

er

Monitor Current Readings

Graph
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Getting the RTR-5W Ready to Use

■ Connect the supplied AC adaptor
*To ensure a proper connection make sure that the plug is completely inserted

NOTE:
- Do not use an AC adaptor other than the one that is supplied with the product. Doing so may cause fire or 

other trouble. 
- Insert the AC adaptor plug into an AC 100 to 120V socket. Inserting the plug into a socket with different 

voltage may cause fire or other trouble. 
- Do not insert or pull out the AC adaptor plug with wet hands or if there are water drops on the plug; it may 

cause electrocution.

■ Connect the supplied LAN cable
* To ensure a proper connection make sure that the connector is completely inserted.
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Communicating with the Data Logger

It is possible to communicate between an RTR-5W base station and Data Loggers  
RTR-51/52/52Pt/53, RVR-52A by two methods: "Wireless Communication" and "Optical 
Communication".

■ Communicating with a Data Logger via Optical Communication
Optical communication can be carried out by placing an RTR-51/52/52Pt/53, RVR-52A 
Data Logger face down on the RTR-5W so that the optical communication areas meet. 

*To make measuring mode changes in an RVR-52A, use via optical communication when 
registering a Remote Unit. 

Optical Communication Area

Place a Data Logger face 
down on the RTR-5W

■ Communicating with a Data Logger via Wireless Communication
Communication is carried out with the RTR-51/52/52Pt/53, RVR-52A Data Loggers via 
special short wave wireless communication. 
In order to carry out Wireless Communication, use the supplied software RTR-5W for 
Windows to register the Data Loggers as Remote Units of the RTR-5W Base Station. 

*The wireless communication range, if unobstructed and direct, is about 100 meters.
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External Output

■ Connecting the Signal Wire

1. Prepare a Φ 0.5 to 0.9 single type wire and remove the covering to about 10mm 
from the tip. 

2. Using a screwdriver or other such tools, while pressing down on the <terminal 
Button B> at the back of the unit, insert the wire into the <hole A>. 

<A>

<B>

Enlarged view of Wire 
Connection Terminal 

◆ External Output : With Warning ON
Voltage when OFF:AC/DC less than 50V
Current when ON:less than 0.1A
Resistance when ON:35Ω

◆ Useable Wires 
Compatible Wires : Single wire: Φ 1.0 (AWG18) / Twisted wire: 0.75mm2

Useable Wires :  Single wire: Φ 0.4 to Φ 1.0 (AWG26 to 18)
 Twisted wire:0.3 to 0.75mm2 (AWG22 to 20)
 Cable core diameter: Φ0.18
 Standard Stripping Length : 0.39in
Compatible Connector Tool : Screwdriver (Shaft: Φ0.3 / Blade Tip Width: 2.6)

■ Removing an Input Signal Wire
If you wish to remove an input signal wire, press down on the <B> Button with a 
screwdriver and pull out the wire. 

NOTE:
Please be careful when pulling out the wire.
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Checking your Operating Environment

To properly use the logger, the following operational environment is necessary.

■ PC Operating Environment
OS Microsoft Windows® 7 32/64bit English

Microsoft Windows Vista® 32bit English

Microsoft Windows® XP 32bit English

Microsoft Windows® 2000 English
 *For installation, it is necessary to have Administrator (Computer Administrator) rights. 

PC/CPU A Stable Windows Operating Environment

LAN TCP/IP Communication Possible

Memory Enough memory to stably operate Windows

Hard Disk More than 10 MB of free space (Data will need more space)

Monitor SVGA (higher than 800× 600 recommended) more than 256 colors

LAN 100BASE-TX or 10BASE-T 

Twisted pair cable confirming to Category 5(STP/UTP)

Web Browser Internet Explorer 6.0 or higher

■ Using a LAN
Connect the provided LAN cable to the HUB that is connected to your computer. 

■ Connecting Directly to a PC
Connect the RTR-5W to your computer with a LAN cross cable. 

■ Using a Wireless LAN
Please use a Wireless LAN card and a Wireless LAN access point (Combined Wireless 
LAN and Hub OK). 
*For more about Wireless LAN connections please refer to: FAQ’s >> Q&A about RTR-5W >> 
Q.6 “I want to use a wireless LAN… “(p.137)

■ Using the Internet
In order to connect to the Internet, you must first make arrangements with a provider for 
a line. 
It may also be necessary to get an IP address or domain and make domain name 
server and other settings. 
For more details about various settings, it is best, if present, to contact the network 
administrator. To get more details about your Internet connection and setup, please 
contact your provider. 
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Connecting to a Network

The following are some ways to connect an RTR-5W to a network. Please select the 
connection method that suits your network environment. 

■ Connecting to a HUB for in-company Communication
*To ensure a proper connection make sure that the plug is completely inserted.

Connection Example

■ Connecting Directly to PC for Communication
Do not use the supplied cable; please purchase a cross LAN cable separately.

*To ensure a proper connection make sure that the plug is completely inserted.

Connection Example 
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■ Connecting to a Wireless LAN
By inserting a Wireless LAN card into the RTR-5W, it is possible to carry out 
communication in places where LAN wiring is difficult or troublesome. 

*To ensure a proper connection make sure that the wireless LAN card is completely 
inserted.

NOTE:
- Before you insert or take out the LAN card, make sure that the AC adaptor is unplugged. 
- For more about Wireless LAN connections please refer to: FAQ's >> Q&A about RTR-5W >> Q.6"I  want to 

use a wireless LAN…  "(p.137)

Connection Example 
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Connecting to the Internet

In order to connect the RTR-5W to the Internet, you must first set up an Internet connection 
environment by making arrangements with a provider for a line and get a global IP address 
and domain. Also, if necessary, make all domain name server and / or router settings. 
For more details about various settings, it is best, if present, to contact the network 
administrator. To get more details about a global IP address and domain, please contact 
your provider.
The following are examples of connection methods. Please select the connection method 
that suits your network environment. 

Connection Example

■ Using the RTR-5W on the Internet

In order to access the RTR-5W from your browser, enter the Global IP address that has been assigned to the 
RTR-5W in your browser's URL bar following [http://]

The RTR-5W will be called via a router or the Internet provider.

The RTR-5W which received the access request will return data to the computer which sent the access request. 

■ Using a Domain Name (ex: rtr-5w.net)

In order to access the RTR-5W from your browser, enter the Domain Name (Ex: rtr-5w.net) that has been 
assigned to the RTR-5W in your browser's URL bar following [http://].

The Domain Name that was entered in the URL bar is converted by the DNS server into an IP address and the 
RTR-5W is called. 

The RTR-5W which received the access request will return data to the computer which sent the access request. 
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■ Using Mail via LAN

① The RTR-5W accesses the SMTP server and sends mail to the server.

② The SMTP server delivers the mail sent from the RTR-5W according to the address to a POP server. 

③ The POP server receives the delivered mail from the SMTP server and stores it in the appropriate mailbox for 
that mail address. 

④ Your computer accesses the POP server where the mail is stored and receives mail in the computer 's mailbox. 

NOTE:
Please take note that when you are using a LAN to send and get warning mail, it is necessary to have set up 

a SMTP server (for sending) and a POP or IMAP server (for receiving) in the network. 

■ Sending Internet Mail

① The RTR-5W, via a router or provider, accesses an SMTP server that exists on the Internet and sends mail to 
the SMTP server. 

② The SMTP server delivers the mail sent from the RTR-5W, according to the address, to a POP server. 

③ The POP server receives the delivered mail from the SMTP server and stores it in the appropriate mailbox for 
that mail address. 

④ Your computer accesses the POP server where the mail is stored and receives mail in the computer's mailbox. 

NOTE:
In order to connect to the Internet, please make the necessary router (LAN) settings.



24

Installation

Install the provided software. 

- Is Windows operating properly?

If Windows is not operating properly, RTR-5W for Windows may not be installed correctly or it 
may not operate properly.

- Please quit all other applications.

If other programs are open, please close and quit all of them, making sure to quit all Quick Start 
programs such as a virus checker.

*To install [RTR-5W for Windows], it is necessary to have Administrator rights (Computer 
Administrator) for the computer in which you wish to install it. 

The layout of the installation window for “Windows 7” closely resembles that of “Windows 
Vista”. When using “Windows 7” to install the Software, please refer to the installation 
instructions found under “Windows Vista” in the User’s Manual provided with the product 
and follow on-screen messages as they appear.

For information about operating the software, please carefully read the important notices 
and instructions found in the User’s Manual.

■ For Windows XP/2000

1. Open Windows.

2. Place the accompanying CD-ROM into your CD-ROM drive. In a few seconds, the 
[Start] window will appear.
*If that window does not automatically open, please open it by double clicking the CD-
ROM icon in [My Computer] on your desktop. 

Or, if after double clicking the CD-ROM drive, the file appears in the CD-ROM folder, 
double click on the "start.exe" icon.

[Execute]
button

Click
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3. Select [Install RTR-5W for Windows] and click the [Execute] Button to start the 
installation.

4. Continue the installation by following the directions as they appear. 

5. After installation has been completed, [RTR-5W for Windows] will be registered in 
the Window's [Start] Menu.

■ For Windows Vista / 7

1. Start Windows.

2. Place the CD-ROM in the appropriate drive.
* If the window automatically appears, under [Install or run program], click on [Run start.
exe]. 

Check

3. The [Install Program] window will appear. 
*If the [Install Program] Window does not automatically open, please open it by double 
clicking on the CD-ROM icon in [Computer]. 

[Execute]
button

Click
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4. Select [Install RTR-5W for Windows], then click the [Execute] Button, the [User 
Account Controls] window should appear. 
The following will appear: [setup.exe] [Unidentified Publisher], to continue with the 
installation, enter the administrator account password and click the [OK] Button.

5. Click [Next] to start the installation.
Confirming the contents as you go, install the software according to the 
directions.

6. After the application has been installed, the following message will appear. 
Click the [Install ] Button.

[Install]
Button

*After installation is completed, an icon for [RTR-5W for Windows] will appear in the Start 
Menu.
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Using the Network Settings Utility

■ How to Open
From the list of programs in the Window's Start Menu, click on [RTR-5W for Windows] - 
[Network Settings Utility].

■ Using Help
For details about how to use the software, please see the explanations in the Software 
Help Menu.

- By clicking on [Help] in the Menu Bar and then [How to Use Network Settings Utility] you 
can click on one of the tabs [Contents] or [Index] to search for the topic or term you are 
unsure about or have questions about.

[Contents]

By clicking on one of the topics listed, you can find detailed information for that subject. 

[Index]

By selecting a Keyword in the Keyword list, and clicking the [Display] Button at the bottom, a 
detailed explanation will appear. 

- By clicking the help button in a dialog box, an explanation for that dialog box will appear.
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■ Network Settings Utility Functions
The Network Settings Utility contains the following functions:

Network Initialization Settings
After purchasing a RTR-5W unit, the first step is to make all Network Initialization Settings 
including assigning an IP Address and a Subnet Mask. 

Detailed Network Settings
The reception of RTR-5W settings and more detailed network settings can be made here.  
In the SNTP settings, it is possible to make settings so that the RTR-5W clock settings can 
be automatically received from NTP server. Clock settings can be made directly using [RTR-
5W for Windows] software, but if an RTR-5W is rebooted (restarted) the clock settings will be 
initialized. However, by making settings to enable the SNTP server it is possible to have the clock 
automatically reset to the current time upon rebooting.

NOTE:
Please open the Network Settings Utility from only one computer at a time in the same network (same 
broadcast domain). 
If you open the Network Settings Utility on multiple computers in the same network, it may not work properly.

[MENU]

- [Menu] - [Login History]

If you wish to disable the History Function, select [Login History] → [OFF].

- [Menu] - [Clear Login History]

Use this to erase the entire login history. 

- [Menu] - [Communication Time Settings]

It is possible to change the communication time for all types of communication depending on 
your network environment.
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Network Initialization Settings

To connect an RTR-5W to a network, it is necessary to enter an IP Address and Subnet 
Mask that are appropriate for your network.

NOTE:
Please note, that upon purchase, all RTR-5W units are set with the same IP address. To make IP address 
changes, connect one unit at a time and carry out the changes. Do not connect more than one unit with the 
same address to the network at the same time.

1. Connect the RTR-5W to the same network as to which the computer you have 
opened [Network Settings Utility] is connected to. 

2. Click on the [Network Initialization] Tab and then click on the [Search] Button. 
After clicking, the search results will be shown in about 5 seconds.

*The factory default settings for RTR-5W are as follows: IP Address: "192.168.1.200", 
Subnet Mask: "255.255.0.0". The MAC address is written on a sticker on the back of the 
RTR-5W unit.

[Change Settings]
Button

[Search]
Button

Connected RTR-5W

3. From the displayed list, select the RTR-5W to which you wish to make settings by 
clicking on the IP address and click on the [Change Settings] Button.
- Also, by double clicking on the IP address, the [Network Settings] window appear.
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4. Enter an IP Address and Subnet Mask.
- Make sure to enter an IP Address and Subnet Mask that are appropriate for your 

network.
NOTE:
Do not use the same IP address for two different units. It may cause abnormalities to the entire network 
system. 

Enter an IP address 
and Subnet mask

[Send]
Button

Enter the Login ID and
Password

5. After entering the above, next, enter the Login ID and Password.
The RTR-5W factory default Login ID is "wsc-user" and the Password is "wsc-passwd". 
Make any necessary changes to the Login ID and Password in the [Detailed Network 
Settings]. See p.31-34 for details. 

6. After checking for entry errors, click the [Send] Button. After transmission has 
been completed a message will appear. 

Click the [OK] Button to finish.

* After settings are completed the RTR-5W will automatically restart. During the 
restarting process, a search cannot be performed, even if you click the [Search] 
Button. Please try again after 30 seconds.

If no units are detected
- Check the connection between the computer and the RTR-5W.

- Check the hub power switch and the network cable type.

- If some network environments, it may be necessary to make changes to the IP address 
and subnet mask at the computer side in order to carry out a search. For details, see 
p.127-129 [Checking and Making Changes to Computer Network Settings]

- Do not use a LAN card which has not been formatted. 
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Detailed Network Settings

After making the network initialization settings for the RTR-5W, the reception of RTR-5W 
settings and more detailed network settings can be made.

*Before making any of these settings, please make sure that the RTR-5W is set with the 
proper IP address. 

■ Receiving Settings

1. Click the [Detailed Network Settings] Tab.

2. In the "Receive Settings" Area, enter the information for the RTR-5W you wish 
to make settings for and click the [Get Settings] Button. The current settings will 
appear. 
-A list that shows all of the IP addresses and domain names with which successful 
communication has occurred until now can be viewed in the [Settings History] pull down 
menu.  
If you select an IP address or domain name here, the Login ID, Password and Port 
Number will be entered automatically. 

* Note that if you have turned [OFF] the [Login History] in the [Menu], or if you have 
deleted the Login history by having clicked [Clear Login History] the Settings History 
will not appear. 

Enter info for the RTR-5W 
you wish to make settings in

[Get Settings] Button

[Change Settings]
Button

[Settings History]
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■ Making Settings (Changes)

1. In the [Detailed Network Settings] window, click the [Change Settings] Button and 
make any necessary changes.

[Send Setting]
Button

Enter info for the RTR-5W you 
wish to make settings in.

2. After making the settings, enter the info for the recipient of the settings and click 
the [Send Settings] Button.

3. A message will appear asking you if it is OK to restart the system. Click the [Yes] 
Button to restart. 

*The new settings will not become valid until the RTR-5W communication function is 
restarted.

[Yes]
Button

4. After restarting has finished, the settings will have been completed. 
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[Mail Auth Settings] Button
In order to send warning report mails from the RTR-5W, it is necessary to make the 
following settings if you are using an SMTP server that requires SMTP authentication or 
POP before SMTP.  

1. In the [Detailed Network Settings] window, click the [Mail Auth Settings] Button 
and make any necessary settings changes.

*For details about making settings changes, see the [Help] Menu in the [Network 
Settings Utility].

[Mail Auth Settings]
Button

2. After having made the desired settings, click the [OK] Button. 

[OK]
Button

3. In the [Detailed Network Settings] window, click the [Send Settings] Button and 
reactivate communication in the RTR-5W.

*The new settings will not become valid until the RTR-5W communication function is 
restarted.
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[Re-Activate Communication] Button
If the browser does not open, wireless communication continually results in failure, or if any 
errors occur during communication, click the [Re-activate Communication] Button. 
Note that by restarting, the data transfer graph in the RTR-5W Web Viewer will also be 
reset. 

[Re-Activate Communication]  
Button

NOTE:
Note that by clicking the [Send Settings] Button or the [Re-activate Communication] Button over and over, 

communication may become impossible. Please try again after 20 seconds.
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Returning the Network Settings to the Factory 
Default Settings

If you have forgotten the IP address or the password you can easily return the logger to the 
default factory settings. 

1. Pull out the AC adaptor plug from the RTR-5W logger. 

2. Press in the [RESET] Button on the RTR-5W logger with a pointed object and 
reconnect the AC adaptor. 

[RESET] Button

3. When the [Power] lamp on the face of the RTR-5W logger starts blinking, release 
the [RESET] Button and the unit will have been returned to the factory default 
settings. 
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RTR-5W Clock Settings

If the clock settings for the RTR-5W are not set correctly, the clock in the RTR-5W Web 
Viewer and the time of warnings will also be incorrect. Please make sure to set correctly 
before beginning to use.

■ Automatic Setting of the Clock
Normally, when an RTR-5W is rebooted the clock settings will be initialized. However, by 
making settings to enable the SNTP server it is possible to have the clock automatically 
reset to the current time upon rebooting.

*The SNTP (NTP) server is a server that automatically adjusts the clock settings of a 
terminal on a network.

1. Open the [Network Settings Utility], click on the [Detailed Network Settings] tab, 
and gather the settings for the RTR-5W that you wish to make settings for. 

2. Click the [Change Settings] Button and the window will appear where you can 
make changes to the settings.

SMTP Settings

3. Under [SNTP Settings], click "ON" to change the setting.

【How to find an NTP server】

-If you are connected to an intra company LAN, you may already have an NTP server for your 
network. Please ask your network administrator for details.

-If you are connected to the Internet, some providers will have an NTP server open to the 
public. Please ask your provider for details.

-If you wish to use an NTP server that is open to the general public on the Internet, it is 
possible to make a search for "NTP server" using Yahoo or Google. Many universities or 
scientific facilities will have an NTP server open to the public. Make sure to use the server 
which is closet to your location. 
Please also make sure to check whether connection is free and without limitation.  
It should also be noted that depending on your Internet connection and your firewall settings, 
the NTP packet may be prohibited from being accepted into your system.
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4.  After making the settings, enter the info for the recipient of the settings and click 
the [Send Settings] Button.

[Send Setting]
Button

Enter the information for the recipient

5. A message will appear asking you if it is OK to restart the system. Click the [Yes] 
Button to restart. 

*The new settings will not become valid until the RTR-5W communication function is 
restarted.

[Yes]
Button

6. After restarting has finished, the settings will have been completed.
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■ Making the Clock Settings Manually
*If you wish to manually set the clock, please carry out settings only after having created a 
Location.

NOTE:
If you make clock settings manually, the clock will lose its settings upon removal of the AC adaptor or after 
restarting the system. Hence, it is necessary to reset the clock after having restarted the system or having 
lost AC power.

1. Open [RTR-5W for Windows].

2. Open the Properties for the Location (RTR-5W) you wish to make settings for. 
In the [Registration / Administration] Menu, select [Location (RTR-5W) Properties] or 
by right clicking on the Location icon, a popup menu will appear where you can select 
[Location (RTR-5W) Properties] to display the properties window.

[Set Clock]
Button

3. Click the [Set Clock] Button and set the current date and time.
- If you wish to set to the same time as your computer clock, select [Set using the 
Computer clock settings].
*Make sure that the computer clock settings are correct before choosing this method. 

- If you wish to directly enter a specified date and time, select [Set using the Computer 
clock settings] and enter the desired settings.

[Set]
Button

4. Click the [Set] Button to send the settings to the RTR-5W and complete the 
settings.
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How to Operate RTR-5W for Windows 

■ How to Open
From the list of programs in the Window's Start Menu, click on [RTR-5W for Windows] - 
[RTR-5W for Windows] to open. 

■ Using Help
For details about how to use the software, please see the explanations in the Software 
Help Menu.

- In the Menu Bar, click [Help] - [Search by Topic], then click on one of the tabs [Contents], 
[Index], or [Search] to search for the topic or term you are unsure about or have questions 
about.

[Contents] 

By clicking on one of the topics listed, you can find detailed information for that subject. 

[Index]

By selecting a Keyword in the Keyword list, and clicking the [Display] Button at the bottom, a 
detailed explanation will appear. 

[Search] 

Enter the keyword you wish to search for and click the [List Topics] Button. All topics that 
contain the keyword will be displayed. By selecting a topic and clicking the [Display] Button at 
the bottom, a detailed explanation will appear. 

- By clicking the help button in a dialog box, an explanation for that dialog box will appear.
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■ RTR-5W for Windows Functions
RTR-5W for Windows is designed to allow the user to utilize RTR-51/52/52Pt/53, RVR-52A 
Data Loggers via the RTR-5W Base Station. From the main window it is possible to carry 
out the various tasks such as Registrations, Recording and Warning Monitoring Settings, 
as well as the Downloading of Data. Management of all devices is carried out in the 
application main window out using a tree format with loggers being registered to Groups 
and Groups belonging to Locations RTR-5W.

Toolbar

Menu Bar

Administration 
Tree

Setting Contents Info Area

Menu Bar

The Menu Bar contains various menus which contain a variety of commands. The commands 
within the menus can be used to display or make settings for the various functions.

Toolbar

Icon buttons appear for the most frequently used commands.

Administration Tree

In the tree all registered Locations (item at the top of each tree list), Groups and Remote Units 
can be viewed and managed. 
By right clicking on an icon, a menu will appear with commands for that type of unit.

Settings Contents Info Area

By clicking on an icon (Location, Group, Remote Unit), the settings info for that item will be 
displayed. 
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Remote Unit / Repeater Installation Procedures

1. Connect the provided AC adaptor to the Base Unit (RTR-5W), and connect the 
LAN cable to the PC

For more details see "p.16 Getting the RTR-5W Ready to Use".

2. Register Groups and Remote Units
Register all Remote Units to be placed.

For more details see "p.44 Remote Registration".

3. Register Repeater Names and Relay Routes.

For more details see "p.51 Repeater Registration".

NOTE:
There is no need to register a Repeater if there are no Repeaters between a Remote Unit and the 
RTR-50 Base Unit. However, if communication cannot be successfully carried out due to poor radio wave 
reception, please place Repeater(s) between the Remote Unit and the Base Unit.
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■ About Repeaters
A "Repeater" is defined as an RTR-50 Wireless Communication Port that has been 
registered as a "Repeater" to act as a relay for Wireless Communication between a Base 
Unit and Remote Units from the our RTR-5 Series.

[Limitations when using a Repeater]
Although it is logically possible to register up to 250 Repeaters in a route, each additional 
Repeater added to the route will proportionately increase communication time. To download a 
the full amount of data from one Remote Unit without any Repeaters will take about 7 minutes, 
hence with the addition of each Repeater the amount of necessary communication time will be 
increased by 7 minutes. If there are 10 units, the necessary time would reach about 70 minutes. 
Communication time for an RTR-50 is set to be limited to no longer than 2 hours and 30 
minutes. For this reason, if there were 250 Repeaters it would be impossible to download the 
full data of even one Remote Unit. If it is necessary to download a unit with full data, then it is 
also necessary to have no more than 20 Repeaters. 
For all communications other than downloading, no conflict with the time limitation will occur, 
even if there are 250 Repeaters present.

[Image of Repeater Registration]

Once the registration of a Repeater is complete, a Repeater Number will automatically be 
assigned to each Repeater.
Also, when carrying out Repeater Registration it is possible to assign a "Relay Route Name" 
that can be used to make sure that data is transmitted through a multiple number of Repeaters 
in the specified route.
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NOTE:
It is possible to set up so that more than one Repeater acts as a relay for the same Remote Units. 
However because wireless communication is carried out in Groups of Remote Units, the same Group 
will be relayed through different Repeaters causing inefficiency and an increase in the amount of 
communication time to more than necessary. 
In order to reduce the communication time, please design Relay Routes so that a particular Group of 
Remote Units uses the same Repeater(s).

NOTE:
A Repeater Number will be automatically assigned to Repeaters in the order that they were registered to 
each Route.
Communication among Repeaters will occur in sequence from the one that is closest to the Base Unit. 
Please keep that in mind when placing the Repeaters.

( EX:

Communication will occur sequentially from the first Repeater as shown above.
If the Repeaters are not arranged in numerical sequence from the Base Unit, the communication 
route will be as seen below. This will cause not only the communication distance to increase but 
also the communication time to increase to longer than necessary.

4. After each Registration has been completed, please check the communication 
status by carrying out a Wireless Communication Test from the [Repeater 

Registration] Window under [Communication] - [Wireless Communication Test].
*If no Repeater is registered, the current data from all Remote Units will be gathered to 
confirm the communication status.
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Remote Registration

In order to carry out Wireless Communication between a Data Logger and an RTR-5W 
Base Station, it is first necessary to register the Data Logger as a Remote Unit of that 
RTR-5W. 

■ Creating a Location

1. Open [RTR-5W for Windows].

2. In the [Registration / Administration] Menu, click on [Create Location (RTR-5W)] 
to display a window where you can enter a name for the new Location. 
* In the Location name, you cannot use a space, or any of the following characters 

[\/:,;*?"<>|&].

Enter the Location Name

[OK]
Button

3. After entering the Location Name, by clicking the [OK] Button, the Location will 
be created in the Administration Tree. 

Administration Tree

Location icon
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4. Click on the desired Location Icon. In the [Registration / Administration] Menu, 
select [Location (RTR-5W) Properties] and enter the same IP address that you 
previously entered when making settings in the Network Settings Utility. 
*By right clicking on the Location icon, a popup menu will appear where you can select 
[Location (RTR-5W) Properties] to display the properties window. 

Access Settings

Enter the IP address (or Domain) for the RTR-5W that was entered in the [Network Settings 
Utility]. 

Browser Display Settings

If necessary, make settings in the [Browser Display Settings] Area.
- Select whether to permit or forbid access from a browser by clicking ON or OFF [Make 

access possible from a browser].

- With Data Gathering Intervals for Data Transfer Graph (Selections: none, 15, 20, 30 minutes, 
1, 2, 3, 6, 12, 24 hours) it is possible to make gathering data interval settings for monitoring 
the current readings via the browser and viewing in simple graph form. 

Daylight Saving Time Setting

If you wish to allow the location’s internal clock to automatically change from Standard Time 
to Daylight Saving Time, check [Automatically adjust the location’s internal clock for Daylight 
Saving Time]. By checking this box, settings can be made for automatically changing the 
internal clock from Standard Time to Daylight Saving Time. Daylight Saving Time adjustments 
will be made according to the Time Zone setting which has been made in Windows (time 
difference from GMT). 

NOTE:
If [Automatically adjust clock for daylight saving changes] has not been checked in the "Date and Time 
Properties" Settings in the Control Panel of Windows OS you are using, it will not be possible to make 
Daylight Saving Time setting. In such a case, please check the Settings in "Date and Time Properties" 
and make any necessary changes. 

[Set Clock]button 

[Access Settings]
Enter the IP Address / Domain 

that were assigned when 

making the network initialization 

settings.

[Browser Display Settings]

[Daylight Saving 

Time Setting]

[Send Daylight Saving Time Info to RTR-5W]Button

[Set]button 

[Get Time]button 

[Reboot]button 
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5. After making entries click the [Set] Button to send the settings to the RTR-5W 
that were entered into the [Access Settings] Bar and the settings for the Location 
will be completed. 

[Get Time] Button

Clicking this button will start communication with the Location and will retrieve and display 
the time settings from the Location's internal clock. Due to network delays, this may be a few 
seconds off from the time you receive the settings. 

[Set Clock] Button

If SNTP settings have not been made, click this button to make RTR-5W clock settings. If an 
SNTP server is not being used, please make sure to reset the internal clock to your local time 
before using. This is necessary because each time the RTR-5W is rebooted the internal clock is 
automatically reset to its default setting. See p.36-38 for details. 

[Reboot] Button

This will reboot the RTR-5W. If you have updated the RTR-5W internal script or in some other 
cases it is necessary to reboot the system. Please read the following "NOTE" about the rebooting 
of an RTR-5W.

[Send Daylight Saving Time Info to RTR-5W] Button

Clicking this button will send the Daylight Saving Time info to the RTR-5W at the selected 
Location. If a change is made to the [Daylight Saving Time Setting], make sure to send the new 
settings. Note that to activate the Daylight Saving Time Setting, the RTR-5W may automatically 
reboot after the Info has been sent to the RTR-5W. Please read the following "NOTE" about the 
rebooting of an RTR-5W. 

NOTE: About the Rebooting of an RTR-5W
- By rebooting an RTR-5W, the unit’s internal clock will automatically return to its default settings. If SNTP 

settings have not been made, please make sure to reset the internal clock to your current local time before 
using. See p.36-38 for details. 

- By rebooting an RTR-5W, all warning logs, readings and graphs currently displayed in the browser (data 
files for transfer) will be erased. Note however that, when an RTR-5W is rebooted, the recorded data 
logged in the Remote Unit will not be affected. 
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■ Creating Groups

1. In the [Registration / Administration] Menu, click on [Create Group] to display a 
window where you can enter a name for the new Group. 

*Up to 8 characters can be entered. 

*In the Location name, you cannot use a space, or any of the following characters 
[\/:,;*?"<>|&].

Enter a Group Name

[OK]
Button

2. After entering the Group Name, by clicking the [OK] Button, the Group will be 
created in the Administration Tree. 

Administration Tree

Group Icon

3. Click on the desired Group Icon. In the [Registration / Administration] Menu, 
select [Group Properties] and assign a Communication Frequency Channel for 
the selected Group. 
*By right clicking on a Group icon, a popup menu will appear where you can select [Group Properties] to 
display the same window. 

Assign a Communication 
Frequency Channel

[OK]
Button
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Communication Frequency Channel

- It is possible to set one Communication Frequency Channel (channel 0-21) to each Group. 
If no setting is made, an unused frequency channel will automatically be assigned. If there 
are no unused frequency channels, the channel that is used the least shall be automatically 
assigned.

- If a different Group is located nearby and there is a possibility that communication could 
occur at the same time, please make sure to set the Communication Frequency Channels 
for each Group to a different setting. If two Groups use the same Communication Frequency 
Channel at the same time there is a great possibility that a communication failure will occur.

- Communication Frequency Channel settings can only be made when registering a new 
Group. Once a Communication Frequency Channel setting has been made it cannot be 
changed.

4. Click the [OK] Button to finish the Group settings. 

■ Registering a Remote Unit

1.  Place a Data Logger face down on the RTR-5W. 
-See p.17 for more details about how to connect. 

2. Select the Group in which you wish to register Remote Units from the 
Administration Tree. In the [Registration / Administration] Menu, select [Remote 
Unit (RTR-5, RVR-5) Registration] to display the Remote Unit Registration window. 
*By right clicking on a Group icon, a popup menu will appear where you can select 
[Remote Unit Registration] to display the Remote Registration window. 

*If an exclamation mark " ! " is next to a Location Icon, make sure to carry out [Send 
Group / Remote Info] after having made settings. 

Administration Tree

Select the Group into 
which you wish to 

register a Remote Unit. 
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3. Enter a name for the Remote Unit and click the [Register] Button to finish the 
registration. 
- If you are using an RVR-52A logger, click the [Voltage:instantaneous value] Button 

and select the desired measuring mode. 

[Register]
Button

Enter the Remote 
Unit Name

[Voltage:instantaneous value]
Button

Remote Units that have 
already been registered

*If you wish to register other Remote Units, repeat the process as in steps 1 to 3. 

■ Sending Registration Info to an RTR-5W 

1. Select a Location from the Administration Tree, and in the [Settings] Menu, select 
[Send Group / Remote Info]. 

[Send]
Button

2. Click the [Send] Button to send the registration info to the RTR-5W and complete 
the settings.

*Make sure to carry out this operation each time changes are made to settings.
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■ Wireless Communication Test
If no Repeaters exist, gather the current data readings from each Remote Unit and check 
to make sure that wireless communication is possible between the Remote Units and the 
RTR-5W Station.

1. Place a Remote Unit in the actual place from which you wish to measure and 
record data. 
- The wireless communication range, if unobstructed and direct, is about 100 meters 

"330 ft".

2. Select the placed Remote Unit from the Administration Tree, and in the [Data] 
Menu, select [Gather Current Data]. 

*By right clicking on the Remote Unit icon, a popup menu will appear where you can 
select [Gather Current Data] to display the [Gathering Current Data] window. 

Selected Remote 
Unit is displayed

3.  Click the [Gather] Button to start communication with the Remote Unit and the 
current data readings will be displayed. 

[Gather]
Button

If the current readings are not displayed, move the Remote Unit to a different Location 
and try gathering the current data again. 
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Repeater Registration

In order to add a Repeater to enhance communication between Data Loggers and an RTR-
5W Base Station, it is first necessary to register an RTR-50 Wireless Communication Port 
as a Repeater.

■ Installing the USB Device Driver 
 To install "RTR-5W for Windows", it is necessary to have Administrator rights (Computer 
Administrator) for the computer in which you wish to install it. 
When using “Windows 7” to install the USB Device Driver, please refer to the installation 
instructions found under “Windows Vista” in the User’s Manual provided with the product 
and follow on-screen messages as they appear.

For Windows 2000 / Vista / 7
When installing the software "RTR-5W for Windows", the USB Device Driver will also be 
installed automatically. 

Checking the USB Device Driver Installation... For Windows Vista / 7 

1. Connect the RTR-50 (Repeater) to the Computer with a USB cable. For how to 
connect to a computer, see the User's Manual that accompanies your RTR-50 

Wireless Communication Port. 

2. Open the [Control Panel] and click on [System and Maintenance]. Then click on 
[Device Manager]. 

For the "Classic View", click on the [Device Manager] icon. 

3. In the [Device Manager] Window, check to see if [USB Recorder 2] is listed under 
[USB Recorder COM].
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Checking the USB Device Driver Installation... For Windows 2000

1. Connect the RTR-50 (Repeater) to the Computer with a USB cable. For how to 
connect to a computer, see the User's Manual that accompanies your RTR-50 

Wireless Communication Port. 

2. Open the [Control Panel] and double click on [System]; the system properties will 
be displayed.

3. Click the [Hardware] Tab, and click the [Device Manager] Button in the Device 
Manager Area.

4. In the Device Manager Window, check to see if [USB Recorder 2] is listed under 
[USB Recorder COM].
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■ Installing the USB Device Driver 
 To install "RTR-5W for Windows", it is necessary to have Administrator rights (Computer 
Administrator) for the computer in which you wish to install it. 

For Windows XP
Before installing the USB device driver, make sure to install the software "RTR-5W for 
Windows" first. 

1. Turn on your computer and open Windows. 

2. Connect the RTR-50 (Repeater) to the Computer with a USB cable. For how to 
connect to a computer, see the User's Manual that accompanies your RTR-50 
Wireless Communication Port. 

3. By connecting the RTR-50 to the computer, the [Found New Hardware Wizard] will 
automatically open.  

If that window does not automatically open, see the next page. If the following 
window will appear, check [No, not this time] and then click the [Next].  
Windows such as this will not appear for "No Service Pack" and "Service Pack 1" 
versions of Windows XP.

[Next]
Button

Check

4. By checking [Install the software automatically (Recommended)] and clicking 
[Next], the software will automatically be installed. 

[Next]
Button

Check
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5. After completing installation, click the [Finish] Button. 

If the driver is not automatically detected
Follow the directions below to install.

1. Disconnect the USB cable from the Data Collector and then re-connect it. 

2. The [Add New Hardware Wizard] will automatically open.
- If a window appears such as the one below, check [No, not this time] and then click 
the [Next] Button.

* Windows such as this will not appear for "No Service Pack" and "Service Pack 1" 
versions

[Next]
Button

Check

3. By checking [Install from a list or specific location (Advanced)] and clicking [Next], 
the installation process will begin.

[Next]
Button

Check
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4. Place a check next to [Include this location in the search:], click the [Browse] 
Button and specify the location of the driver. 

Check

[Next]
Button

[Browse]
Button

- Select the driver for the device being used from the folder where [RTR-5W for 
Windows] was installed. 

・ For RTR-50... RTR-5W for Windows\Driver RTR-50

- Insert the CD-ROM into the proper drive and from the CD-ROM select the driver for 
the device being used. 

・ For RTR-50... CD-ROM Drive\DeviceDriver\RTR-50

5. After having selected the correct driver, click [Next] to start the installation.
After completing the installation, click the [Finished] Button.
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Checking the USB Device Driver Installation... For Windows XP

1. Connect the RTR-50 (Repeater) to the Computer with a USB cable. For how to 
connect to a computer, see the User's Manual that accompanies your RTR-50 

Wireless Communication Port. 

2. From the [Control Panel], click on [Performance and Maintenance] - [System]; the 
system properties will be displayed.

3. Click the [Hardware] Tab, and click the [Device Manager] Button in the Device 
Manager Area.

[Device Manager]
Button

[Hardwere] Tab

4. In the Device Manager Window, check to see if [USB Recorder] is listed under [USB 
Recorder Com]*1.

*1： For RTR-50... [USB Recorder Com] - [USB Recorder2]

NOTE:
- If under [USB Recorder Com] – [USB Recorder*] there appears a " ! " or a " ? ", or if in the Device 

Manager Window [? Other device?! USB Device] appears; that means the USB driver has not been 
installed properly. Please see [If USB Device Driver Installation Fails] (p.130) and re-install the driver as 
instructed. 
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■ Registering a Repeater

1. Connect the Repeater you wish to register to your computer with a USB or Serial 
Communication Cable.

*If you are using the RTR-50 with a USB cable it is necessary to carry out directions 
for "Installing the USB Device Driver" or if you are using a serial cable it is necessary 
to carry out instructions for "Communication Port Setting". For more details, see either 
the User's Manual that came with "RTR-50 for Windows" or the Help Menu found in 
"RTR-50 for Windows".
NOTE :
Application version 1.40 is not compatible for USB communication with Windows Vista / 7 OS.

2. Open [RTR-5W for Windows]. 

3. In the [Registration / Administration] Menu, click on [Repeater Registration] to 
display a window which shows a list of the current Registration contents. 

Registration 
List

4. After entering a Relay Route Name, click the [New Registration] Button to view 
the Registration list and complete the Repeater Registration.

[New Registration]
Button

Relay Route Name
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Com. Fre. Ch

- Here it is possible to set the frequency channel for when registering the new Relay Route 
name.

- The "Relay Route Frequency Channel" is the channel used for the communication among 
Repeaters and is different from the term "Frequency Channel" which means the channel 
used for the communication between the Base and Remote Units. So, no trouble occurs if 
the number for the "Frequency Channel" set when registering a Remote Unit to a Group is 
different from the number used for the "Relay Route Frequency Channel" when adding a 
Repeater to a Relay Route. 

- Once a setting has been made it cannot be changed.

Memo

It is helpful to make a memo entry here in order to distinguish between Repeaters. (Up to 8 
characters can be entered.) 
You may leave this field blank if not necessary and should note that changes cannot be made 
after registering a Repeater. If you wish to make changes, it is necessary to create the Relay 
Route again.
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■ Assigning Remote Units to a Repeater

1. From the current Registration contents, select the Remote Units that you wish to 
assign to a Repeater; by right clicking a menu will appear.

Registration List

2. By clicking "Assigning Remote Units to a Repeaters", a display will appear in 
which you can select the Repeater. 
Select the Relay Route and Repeater number; then click the [OK] Button to finish the 
setting process.

[OK]
Button

*By selecting the Remote Unit you wish to add to a Relay Route and dragging and 
dropping it to the Repeater to which you wish to assign it, that Remote Unit will added 
to the selected Relay Route.
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Removing a Remote Unit from a Relay Route
From the Registration List, select the Remote Units which you wish to remove from the Relay 
Route. By right clicking a menu will appear; select "Use No Relay" and the Remote will move to 
be directly under the Base Unit. 
This can also be done by selecting the Remote Unit which you wish to remove from the Relay 
Route from the Registration List and drag and drop the Remote to directly under the Base Unit.

[Repeater Info / Delete / Initialize] Tab

[Delete Route]
Button

[Delete Repeater]
Button

[Replace Unit] 
Button

[Initialize] Button

[Repeater Info / Delete / Initialize] tab

Repeater Info

View Repeater Info for the unit(s) selected from the Registration List.
- Relay Route Name: the Relay Route Name will appear.
- Communication Frequency Channel: the Communication Channel for the Relay Route to 

which the Repeater belongs will appear.
- Repeater Number: the number of the Repeater will appear.
- Repeater Memo: displays any Memos written for the Repeater.

[Delete Route] Button

This deletes the Relay Route selected from the Registration List. 
By deleting a Relay Route all Repeaters within that route will also be automatically deleted and 
all Remote Units that had been assigned to the route will be returned so as to be directly under 
the Base Unit.



61

[Delete Repeater] Button

This deletes the Repeater selected from the Registration List. 

* When using more than one Repeater, only the last one in the Route can be deleted. If you wish 
to delete Repeater(s) other than the one last one in the Route, it is necessary to either delete 
each Repeater in sequence from the last to the one(s) you wish to delete, or delete the entire 
Relay Route itself (as above in "Delete Route") and register Repeaters to design a Route again.

[Replace Unit] Button

If you wish to replace a Repeater with a new one due to malfunction or trouble without changing 
the Route design, connect the new Repeater to the computer via a USB or Serial Cable and 
click this button. The prior Repeater Info will be registered into the new Repeater. 

*All Remote Units that were assigned to the Repeater that was changed will be returned to 
be directly under the Base Unit. If necessary, please reassign those Remote Units to the new 
Repeater. 

[Initialize] Button

Connect the Repeater you wish to initialize to your computer with a USB or Serial 
Communication Cable, and click the [Initialize] Button.

NOTE:
By initializing all info saved in the Repeater will be erased and will be returned to as it was when it left the 
factory (as a Base Unit used for another T&D product).

[Get Repeater Info] Tab

[Get Unit Info] Button

[Get Repeater Info] tab

Connect the Repeater from which you wish to get info with a USB or Serial Communication 
Cable, and click the [Get Unit Info] Button.

- Results: Displays whether the connected unit has been Initialized or registered as a "Repeater"  
*The Initialized setting is as a Base Unit for another T&D product.  
*In the RTR-5W system this can only be used as a Repeater. 

- Relay Route Name: the Relay Route Name will appear.

- Communication Frequency Channel: the Communication Channel for the Relay Route to which 
the Repeater belongs will appear.

- Repeater Number: the number of the Repeater will appear.

- Battery Level: the remaining amount of battery power will appear for the Repeater. (0: No Battery 
– 5: Full)
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■ Wireless Communication Test

1. In the [Repeater Registration] window, select [Communication] - [Wireless 
Communication Test]. 

2. Select the Search method and click [Start Communication] to begin. 

[Start Communication]
Button

Test All Remote and Repeaters

This will test and gather signal strength to all Remote Units listed in the Registration List via all 
Repeaters as they are set up as well as all Remote Units that communicate directly with the 
Base Unit.

Remote Unit Group

The signal strength for the Remote Units which belong to the Group selected from the "Remote 
Unit Group" List will be displayed.

Relay Route

- All Routes : This will show signal strength for all Remotes and Repeaters in all Routes.
* This will not test Remote Units that are not assigned to a Relay Route and communicate 
only directly with the Base Unit. 

- Selected Routes : This will show signal strength for all Remotes and Repeaters in Routes that 
have been selected under [Relay Route Names].
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3. The Communication Test results will appear. 

Communication Successful The number of vertical lines shows the Radio Wave 
Strength. (Min: 1 / Max: 5)
If testing is of a Repeater, the Radio Wave Strength shown will be for between 
that Unit and the Unit with one number before it. (If the Repeater Number is 1 
then the Strength shown will be for communication with the Base Unit).

Communication Failure Appears in front of the Remote or Repeater Name for 
which a communication failure has occurred.

Appears in front of the Remote or Repeater Name for which the test has not 
been selected in the test mode (communication does not occur).

*If a communication failure has occurred, check the Repeater / Remote Unit location 
and the remaining battery life.
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Recording Settings

Note:
- If the computer clock is set incorrectly the programmed start time will also be incorrect. Make sure the clock 

settings are correct before starting a recording session.

- When using RTR-52Pt, please makes sure to carry out sensor settings as detailed in "RTR-52Pt Sensor 
Settings" on p.118.

1. Open [RTR-5W for Windows].

2. From the Administration Tree, select the Remote Unit for which you wish to make 
recording settings, and in the [Settings] Menu, select [Start / Stop Recording]. 

3. Setting the Recording Conditions.

Communication Method :[Select from: Wireless Communication / Optical Communication]

Select the communication method to be used between the Remote Unit and the Base Station 
(RTR-5W). 

*If more than one Remote Unit have been selected, only wireless communication can be used. 

Recording Start Time: [Select from: Immediate Start / Programmed Start]

Programmed Start: Recording will begin on the set date and time.
Immediate Start: Recording will start after the [Start Recording] Button has been clicked. 
When using RTR-51/52/53 units, by selecting the type of unit it is possible to view the 
estimated recording finish time.

Recording Interval: [Select from: 1,2,5,10,15,20,30 seconds, or 1,2,5,10,15,20,30,60 minutes]

Click the ▼ Button to select an interval from the list. 

Recording Mode: [Select from: Endless / One Time]

Endless Loop: Upon reaching capacity of 16,000 readings, the oldest data is overwritten and 
recording continues.
One Time: Upon reaching capacity of 16,000 readings, [FULL] will appear in the LCD display 
and recording will automatically stop.
*For RTR-53, the unit will become full at 8,000 readings in each channel.
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Unit of Temperature for Display: [Select from: Celsius or Fahrenheit] for RTR-51/52/53

Here you can shift the unit of display between Celsius (ºC) and Fahrenheit (ºF).

* When using Fahrenheit in the RTR-52Pt LCD, the Logger can only show between -199.9 and 
999.9 F゚. Note that this has no effect on the actual recorded data, but is just a matter of the 
display.

Measuring Mode
(Only RVR-52A)

[Stop Recording]
Button

[Get Setting]
Button

[Start Recording]
Button

Measuring Mode: [Select from: Voltage (instantaneous value / average value) / Pulse 
(Rising / Falling) / Event (Time) / Other (Moisture)] for RVR-52A. 

Voltage: Instantaneous
 value :

Records the voltage at the instant of measurement. 
(Unit of measurement in display: V)

Voltage: Average value : If the recording interval has been set for 15 seconds or lower, the 
average that is recorded will be from measurements every one 
second. If the recording interval has been set for 20 seconds or 
higher, the average that is recorded is from every two seconds. (Unit 
of measurement in display: V)

Pulse: Rising : Records the number of rising pulses during the set recording interval.

Pulse: Falling : Records the number of falling pulses during the set recording interval.

Event: Time : Events within an input voltage range of 0 to 30V are measured for 
every 1 second and the time and date are recorded if any change, 
rising (Lo → Hi) or falling (Hi → Lo), occurs and lasts for more than 1 
second. (There is no set recording interval)

Other: Moisture Record Moisture by Percentage.
The unit of measurement on the display will show [% ] for Percent.

*When measuring moisture, it is necessary to select either [EC-10 Default Values] 
or [EC-20 Default Values] in the [Probe Settings]. To open the [Probe Settings] 
window, click on [Settings] in the Menu Bar and then select [Moisture Probe 
Settings] from the pull down menu.

*To make changes to the measuring mode settings, it is necessary to use optical 
communication.
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4. Click the [Start Recording] Button to send the recording condition settings via 
the RTR-5W Base Station to the Remote Unit and complete the set-up.

NOTE:
By starting a new recording session, all currently recorded data will be erased.

[Get Settings] Button
Gather current recording condition settings from the selected Remote Unit.

*The collecting of current recording settings cannot be carried out on a multiple number of 
Remote Units. 

[Recording Stop] Button
Press to stop recording during a recording session. 

Measuring Moisture (RVR-52A)

1.  When you wish to measure moisture, place the RVR-52A logger face down on the 
RTR-5W to enable optical communication. 

2.  Under [Settings] - [Moisture Probe Settings], click "Get Settings" to gather the 
RVR-52A logger information. 

[Send Settings] 
Button

[EC-10 Default Values]

[EC-20 Default Values]

3.  When measuring moisture, it is necessary to select either [EC-10 Default Values] 
or [EC-20 Default Values] in the [Probe Settings].

4.  Click the [Send Settings] Button to complete the setting process. 
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Downloading Data

It is possible to download recorded data by two methods: [Wireless Communication] or 
[Optical Communication].

NOTE:
If the computer clock is set incorrectly the time of the downloaded data will also be incorrect. Make sure the 
clock settings are correct before starting a downloading session.

■ When using Wireless Communication 

1. Open [RTR-5W for Windows].

2. From the Administration Tree, select the Remote Unit from which you wish to 
download data, and in the [Data] Menu, select [Download Data]. 

Specify the 
download mode

[Download]
Button

[Specify the File Name]
Button

The Info for the selected 
Remote will be displayed.

3. Select the Download Mode.

4. If you wish to save the file by specifying the location, click the [Specify File Name] 
Button and make Saving Location Settings.

5. Click the [Download] Button to start downloading.
Once downloading has been completed, select the name of the Remote Unit from the 
list and click [Open Graph] to view the data in graph form.

[Cancel Downloading] Button
Use this to stop a downloading session in progress.  
Note that if a downloading session is stopped while in progress, the results will NOT be 
saved to a file. 

[Open Graph] Button
Once downloading has been completed, select the name of the Remote Unit from the list 
and click [Open Graph] to view the data in graph form.
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■ When using Optical Communication 

1. Open [RTR-5W for Windows].

2. Place the Remote Unit from which you wish to download data face down on top 
of the specified RTR-5W (Location).

3. From the Administration Tree, select the Location you will use for Optical 
Communication.

4. In the [Data] Menu, select [Download Data (Optical Communication].

[Download]
Button

[Specify...]
Button

Select the 
Download Mode

5. Click the [Specify] Button to specify the file saving location. 
*If only one Remote Unit has been selected, the default file name will appear when this 
window is opened. 

6. Make settings for [Specify the Downloading Mode].

7. Click the [Download] Button to start downloading.
*If you wish to continue downloading from other units, repeat the process as in steps 2 
to 7.

[Cancel Downloading] Button
Use this to stop a downloading session in progress. 
Note that if a downloading session is stopped while in progress, the results will NOT be 
saved to a file. 
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Operating the Temp / Humidity Graph

■ How to Open
From the list of programs in the Window's Start Menu, click on [RTR-5W for Windows] - 
[Temp / Humidity Graph].

■ Using Help
For details about how to use the software, please see the explanations in the Software 
Help Menu.

- In the Menu Bar, click [Help] - [Search by Topic], then click on one of the tabs [Contents], 
[Index], or [Search] to search for the topic or term you are unsure about or have questions 
about.

[Contents] 

By clicking on one of the topics listed, you can find detailed information for that subject. 

[Index]

By selecting a Keyword in the Keyword list, and clicking the [Display] Button at the bottom, a 
detailed explanation will appear. 

[Search] 

Enter the keyword you wish to search for and click the [List Topics] Button. All topics that 
contain the keyword will be displayed. By selecting a topic and clicking the [Display] Button at 
the bottom, a detailed explanation will appear. 

- By clicking the help button in a dialog box, an explanation for that dialog box will appear.

- In the Graph Window, by clicking on the  in the toolbar, you can have short explanations 
appear the next time you click on a menu, an icon, or anything in the main window. 
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■ Temperature / Humidity Graph Display Names and Functions

⑨

⑦

①

⑤

⑩

⑧

⑥⑤

①

③
④

⑦

②

A and B Cursor Movement Buttons 
By clicking the arrow buttons, you can simultaneously move the A/B cursors.

A and B Cursor Buttons 
Click and drag the A or B button to move the cursor to the left or right.

Toolbar 
Buttons appear for frequently used commands.

Menu Bar 
Click on the desired menu in the Menu Bar to set or display each function from which you can choose from 
an array of commands. They can be used to display or make settings for the various functions for each 
menu.

Button for Moving Horizontal Axis 
The time axis moves by clicking these arrow buttons.

Horizontal Gauge Bar 
By dragging the gauge you can move left and right to the data you want to be displayed.

Button for Moving Vertical Axis 
The vertical axis moves up or down by clicking these arrow buttons.

Vertical Gauge Bar 
By dragging the gauge you can move up and down to the data you want to be displayed.

A and B Cursor Position Information 
The approximate date and time for the A and B cursor positions and the time difference between the A 
cursor and the B cursor is displayed.

Channel Info List Display 
The detailed data info for each channel 1 to 8 is displayed below the Graph Display.
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Zoom in Using the Mouse
With the left button drag the mouse to outline the area you want to zoom in on.

Menu Display Using the Mouse
By right clicking on the graph, the Menu will be displayed.

Display Graph Using Drag and Drop
It is possible to view data in graph form by dragging a recorded data file and dropping it 
onto the Graph.

NOTE:
-In Windows Vista and Windows ７, a lower-level User cannot use drag and drop to open a 
File if a higher-level User opened the Graph program. 

For example, if the Graph program was opened using [Run as Administrator] and then 
using Explorer a file is dropped into the Graph window, the file will not appear if Explorer 

was opened using any other User than Administrator. 
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■ Data List Display Part Names and Functions
This is the list of data being displayed in the Graph window.(Open from  [View] Menu.)

[Date/Time] Button
By clicking this button, you can shift the display between the recorded date and the amount 
of elapsed time since recording started.

②

[Date/Time]
Button

①

Recorded Date 
Display

① The highest value is in RED, lowest is in BLUE, and the average is in PINK.

② Scroll Bar: By dragging it up and down you can move to the data you want.

Elapsed Time 
Display

Menu Display Using the Mouse
By right clicking on the Data List, the Menu will be displayed.
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Making Changes to the Graph Display

■ Changing Colors of Data Display Area: From the [View] Menu
You can change the letters used in the data list display for each channel between 
monochrome and channel color.

■ Selected Channels ON / OFF : From the [View] Menu
You can choose to view only the selected channels in the Graph. 

1. By moving the mouse to [Selected Channels ON / OFF], the channel numbers are 
displayed.

2. Click the channel number to remove or place a check mark. Only those channels 
with a check mark next to the number will be displayed in the Graph. 

*The same operation can be done by clicking on the channel number icons in the Toolbar.

Check

Enlarged

■ Setting High, Low, Average Calculation Range: From the [Tools] Menu

1. Enter a calculation range in the [New Calculation Range] 
- By clicking the [Entire Graph] Button, the dates and times for the entire graph will be 
displayed.

- If in the graph display, you place the A cursor at the position for the beginning of the 
calculation range and the B cursor at the end of the range, those dates and times will 
appear as the new range in the [Set High, Low, Average Calculation Range] Display 
when it is opened.

Enter a calculation
range

[OK]
Button

[Entire Graph]
Button

2. Click the [OK] Button to finish the setting process.
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■ Editing Recording Conditions: From the [Tools] Menu
It is possible to make corrections to channel names and to recording start date and times. 

1.  By clicking the [Channel No.] Button of the channel you wish to edit, the [Name] 
and [Started Date / Time] in the "Edit Items" display will show info for that channel 
number.
-Name: Up to 32 letters can be entered.

-Started Date/Time: The month, day, year, hour, minute and second can be changed.

Channel Number

Edit Items

[Restore]
Button

[OK]
Button

2. After making changes, click the [OK] Button to finish.
*If you wish to continue to make changes to other channels, repeat the process as in 
step 1.

*The [Restore] Button is only effective while making changes. After clicking the [OK] 
Button the settings cannot be restored to the original settings.
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■ Re-ordering Channel Data: From the [Tools] Menu
You can re-order the data during graph display.
There are two methods to use when re-ordering channels: [Re-order by Dragging a 
Channel Number] and [Specify the Channel Numbers to be Moved].

【Re-order by Dragging a Channel Number】

Drag the channel number you wish to move to the newly desired channel number position and drop it.

*The [Restore] Button is only effective while making changes. After clicking the [OK] Button the 
settings cannot be restored to the original settings.

Drag the channel number
to the newly desired

[OK]
Button

[Restore] Button

【Specify the Channel Numbers to be Moved】

1. Specify the channels to be moved From: (original position) To: (desired position).

2. Click [Re-order] Button to complete the re-ordering process.
*The [Restore] Button is only effective while making changes. After clicking the [OK] 
Button the settings cannot be restored to the original settings.

If you wish to move Ch.3 to Ch.7
simply set From Ch.3 To Ch.7

[OK]
Button

[Re-order]
Button

[Restore] Button
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■ Erasing Selected Channel Data : From the [Tools] Menu

1. Put a check on the channel number you wish to erase.

2. By clicking on the [OK] Button, the deletion will be completed.

Check

[OK]
Button

Shifting Unit (ºC /ºF) : From the [Tools] Menu
By clicking on [Shift Unit (ºC /ºF)], you can automatically change the temperature unit scale 
in the graph display and in the channel info list.
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■ Changing Graph Colors : From the [Tools] Menu

1. Click the channel number of which you wish to change the color.
You can change the colors of the channel name, graph background, the scale lines, the 
enlarged box area, and the AB cursors. 

Color sample

[Line Width...]
Button

[Default]
Button

[OK]
Button

2. Choose the color you want and click the [OK] Button.

3. After confirming the color, by clicking the [OK] Button the change will be 
completed.

*By clicking the [Return to Default] Button, you will return to the color settings when the 
software was opened.

【Graph Line Width Settings】
Change the width of the data lines and the scale lines.

1. Click on the [ ▼ ] Button to change the width of the graph / scale lines. 
- Every time you click on ▲ , the numerical value gets larger.
- Every time you click on ▼ , the numerical value gets smaller.

[OK]
Button

[Default]
Button

2. Click the [OK] Button to complete the changes. 
*By clicking the [Return to Default] Button, you will return to the color settings when the 
software was opened.
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■ Copying Display to Clipboard : From the [Tools] Menu
By clicking [Copy Display to Clipboard], you can copy the currently displayed window to the 
clipboard and make use of the graph by pasting to other software.
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Operating the Graph Display

■ Returning to Original Size
Clicking here will return the graph to its original size.

■ Zooming In and Out
Zooms in or out one step at a time

■ Moving the A/B Cursors Right and Left
Simultaneously move the AB Cursors to the right or left.

■ Moving Right and Left on the Graph
Move the Graph Display to the right or left.

■ Moving Up and Down on the Graph
Move the Graph Display up or down.

■ Vertical Axis Settings
Set the vertical axis scale range 

1. Check either [Auto] or [Manual].
- AUTO: The vertical axis will automatically be changed according to the values of the 
data.

- MANUAL: You can set the upper and lower values of the vertical axis scale.

[OK]
Button

[Default]
Button

If using manual, enter 
the vertical scale range.

2. Click the [OK] Button to finish.
*By clicking the [Default] Button, you will return to the settings when the software was 
opened.
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How to operate the Multi-scale Graph

■ How to Open
From the list of programs in the Windows Start Menu, click on [RTR-5W for Windows] - 
[Multi-scale Graph].

■ Using Help
For details about how to use the software, please see the explanations in the Software 
Help Menu.

- In the Menu Bar, click [Help] - [Search by Topic], then click on one of the tabs [Contents], 
[Index], or [Search] to search for the topic or term you are unsure about or have questions 
about.

[Contents] 

By clicking on one of the topics listed, you can find detailed information for that subject. 

[Index]

By selecting a Keyword in the Keyword list, and clicking the [Display] Button at the bottom, a 
detailed explanation will appear. 

[Search] 

Enter the keyword you wish to search for and click the [List Topics] Button. All topics that 
contain the keyword will be displayed. By selecting a topic and clicking the [Display] Button at 
the bottom, a detailed explanation will appear. 

- By clicking the help button in a dialog box, an explanation for that dialog box will appear

- In the Graph Window, by clicking on the in the toolbar, you can have short explanations 
appear the next time you click on a menu, an icon, or anything in the main window. 
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■ Multi-scale Graph Display Names and Functions

⑨

⑪

⑦ ⑥⑧⑥

⑩

⑫

④
⑤

③

⑨
②
①

A and B Cursor Movement Buttons 
By clicking the arrow buttons, you can simultaneously move the A/B cursors.

A and B Cursor Buttons 
Click and drag the A or B button to move the cursor to the left or right.

It is possible to hide or view the vertical scale for each channel 
It is possible to hide or view the scale on the graph for each channel.

Toolbar 
Buttons appear for frequently used commands.

Menu Bar 
Click on the desired menu in the Menu Bar to set or display each function from which you can choose from 
an array of commands. They can be used to display or make settings for the various functions for each 
menu.

Button for Moving Horizontal Axis 
The time axis moves by clicking these arrow buttons.

Horizontal Gauge Bar 
By dragging the gauge you can move left and right to the data you want to be displayed.

Vertical Axis Scale for each Channel 
In the graph, the scale for each channel will be shown. By clicking the arrow at the corners of the gauge 
bar you can scroll up or down on the current display while maintaining the present zoom.

Button for Moving Vertical Axis 
The vertical axis moves up or down by clicking these arrow buttons.

Vertical Gauge Bar 
By dragging the gauge you can move up and down to the data you want to be displayed.

A and B Cursor Position Information 
The approximate date and time for the A and B cursor positions and the time difference between the A 
cursor and the B cursor is displayed.

Channel Info List Display 
The detailed data info for each channel 1 to 8 is displayed below the Graph Display.
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Zoom in Using the Mouse
With the left button drag the mouse to outline the area you want to zoom in on.

Menu Display Using the Mouse
By right clicking on the graph, the Menu will be displayed.

Display Graph Using Drag and Drop
It is possible to view data in graph form by dragging a recorded data file and dropping it 
onto the Graph.

NOTE:
-In Windows Vista and Windows ７, a lower-level User cannot use drag and drop to open a 
File if a higher-level User opened the Graph program. 

For example, if the Graph program was opened using [Run as Administrator] and then 
using Explorer a file is dropped into the Graph window, the file will not appear if Explorer 

was opened using any other User than Administrator. 
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■ Data List Display Part Names and Functions
This is a list of the data that was displayed in graph form. From the [View] Menu

[Date / Time] Button:
By clicking this button, you can shift the display between the recorded date and the amount 
of elapsed time since recording started.

②

①

Recorded Date 
Display

[Date/Time]
Button

① The highest value is in RED, lowest is in BLUE, and the average is in PINK.

② Scroll Bar : By dragging it up and down you can move to the data you want.

Elapsed Time 
Display

Menu Display Using the Mouse
By right clicking on the Data List, the Menu will be displayed.
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Making Changes to the Graph Display

■ Selected Channels ON / OFF : From the [View] Menu
You can choose to view only the selected channels in the Graph. 

1. By moving the mouse to [Selected Channels ON / OFF], the channel numbers are 
displayed.

2. Click the channel number to remove or place a check mark. Only those channels 
with a check mark next to the number will be displayed in the Graph. 

*The same operation can be done by clicking on the channel number icons in the 
Toolbar.

Enlarged

Check

■ Scale Channels ON / OFF : From the [View] Menu
You can choose to view only the selected channels in the Graph. 

1. By moving the mouse to [Scale Channels ON / OFF], the channel numbers are 
displayed.

2. Click the channel number to remove or place a check mark. Only those channels 
with a check mark next to the number will be displayed in the Graph. 

*The same operation can be done by clicking on the channel number icons in the 
Toolbar.

Enlarged

Check
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■ Setting High, Low, Average Calculation Range: From the [Tools] 
Menu

1. Enter a calculation range in the [New Calculation Range].

[OK]
Button

[Entire Graph]
Button

Enter the numerical 
values

- By clicking the [Entire Graph] Button, the dates and times for the entire graph will be 
displayed.

- If in the graph display, you place the A cursor at the position for the beginning of the 
calculation range and the B cursor at the end of the range, those dates and times will 
appear as the new range in the [Set High, Low, Average Calculation Range] Display 
when it is opened.

2. By clicking the [OK] Button, the High, Low and Average will change for each 
channel's data list and the graph will change to display that data contained in the 
new range setting.
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■ Editing Recording Conditions: From the [Tools] Menu
It is possible to make corrections to channel names and to recording start date and times. 

1. By clicking the [Channel No.] Button of the channel you wish to edit, the [Name] 
and [Started Date / Time] in the "Edit Items" display will show info for that channel 
number.

Channel 
Number

Edit Items

[Restore]
Button

[OK]
Button

- Name: Up to 32 letters can be entered.

- Started Date/Time: The month, day, year, hour, minute and second can be changed.

2. After making changes, click the [OK] Button to finish.
If you wish to continue to make changes to other channels, repeat the process as in 
step 1.

*The [Restore] Button is only effective while making changes. After clicking the [OK] 
Button the settings cannot be restored to the original settings.
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■ Re-ordering Channel Data: From the [Tools] Menu
You can re-order the data during graph display.
There are two methods to use when re-ordering channels: [Re-order by Dragging a 
Channel Number] and [Specify the Channel Numbers to be Moved].

【Re-order by Dragging a Channel Number】

Drag the channel name / number you wish to move to the newly desired channel name / 
number position and drop it.

[OK]
Button

Drag the channel 
name to the  

newly desired

【Specify the Channel Numbers to be Moved】

1. Specify the channels to be moved From: (original position) To : (desired position).

2. Click the [Change 1 and 2] Button to complete the re-ordering of channels.

[Change 1 and 2]
Button

[OK]
Button

If you wish to move Ch.3 
to Ch.7 In Selection  
1 place Ch3 and in  
Selection 2 place Ch7.
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■ Merging Channel Data: From [Tools] Menu 
It is possible to merge two different pieces of data into one piece of data.

NOTE:
- The following data cannot be merged 
- If the total number of readings after merging exceeds 16,000 data readings. 
- If the recording intervals are different
- If the data is of different types 
- If the conversion equation for the scale settings are different
- If the measuring times overlap (This can be adjusted by using the [Edit Recording Conditions])

1. Click the ▼ Buttons to select the channels you wish to merge.

Channel No.
[Merge]
Button

[OK]
Button

2. Click the [Merge] Button to complete the merging process. 
*The channel number and other conditions for the merged data will be those of the 
channel that was selected first. 
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■ Erasing Selected Channel Data : From the [Tools] Menu

1. Put a check on the channel number you wish to erase.

2. Click the [OK] Button to complete the deletion. 

[OK]
Button

Check 
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■ Setting Vertical Axis Display Range: From the [Tools] Menu
It is possible to set the upper and lower values of the vertical axis scale for each channel.

NOTE:
- In this case, the data graph lines may under certain circumstances stick out of the graph.
- Settings for the upper limit must be 40.000 or lower and settings for the lower limit must be -40.000 or 

higher.

1. Put a check next to <Fixed> for the channel you wish to make settings for. 

Check <Fixed> and 
enter the desired 
numerical values.

[OK]
Button

Make all settings same as Ch. 1

2. Enter the Upper and Lower Limits.

3. Click the [OK] Button to finish the setting process.

Make all settings same as Ch. 1
If you have chosen fixed values for Ch.1 and put a check next to [Make all settings same 
as Ch. 1], the settings will become the same for all other channels whether that channel 
has been set to "Fixed" or "Auto".
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■ Scale / Unit Conversion: From [Tools] Menu
It is possible to make settings for the conversion of units and scales for each channel of 
downloaded data.

1. Select to use 2 voltage points to convert the scale, [Designate by 2 points] or to 
use the conversion equation of [Designate by y=Ax+B].

Conversion Info

[OK]
Button

[Designate by y=Ax+B]

[Designate by 2 points]

2. Make settings for the conversion equation and unit.

3. Click the [OK] Button to finish the setting process.

Conversion Info
The currently set conversion equation and the character array of the current unit will be 
displayed.
By stands for the value after conversion and x is the voltage input directly from the sensor.
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■ Changing Graph Colors : From the [Tools] Menu

1. Click the channel number or item for which you wish to make changes. 
If you wish to change the color: click the appropriate Button to view the color selection 
samples.

If you wish to change the type of line: click the [Line Type] Button to view the line type 
selections.

If you wish to make changes to the width of the lines: In the image preview display, first 
click on a channel number button to select the channel and then each click of the ▲ 
Button will make that channel's line wider and each click of the ▼ Button will make it 
thinner. 

[Close]
Button

Image Preview

Memo

[Default]
Button

[Channel No.]
Button

*If you wish to make changes to the graph colors, line types, or line widths, click on the 
[Channel No.] Button first and then click on the topic you wish to make changes to.

Color SampleChange Line Type
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2. After confirming the color in the image preview display, click the [Close] Button 
to complete the changes. 

*By clicking the [Default] Button, you will return to the color settings to the Default 
settings.

Memo

Here it is possible to save one pattern of settings for use in the display and one for use 
when printing.

1. Select [Display] or [Print].

2. Click the [Save] Button to save the settings.

[Save]
Button

For Display
For Printing

[View]
Button

- By clicking the [View] Button, you can call up a saved pattern.
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Operating the Graph Display

■ Returning to Original Size
Return from zooming in on one part of data to the original whole graph size.

■ Zooming out step by step
Return by regular steps from zooming in on one part of data to show larger ranges of data.
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How to Operate the Event Viewer

■ How to Open
From the list of programs in the Window's Start Menu, click on [RTR-5W for Windows] - 
[Event Viewer].

■ Using Help
For details about how to use the software, please see the explanations in the Software 
Help Menu.

- In the Menu Bar, click [Help] - [Search by Topic], then click on one of the tabs [Contents], 
[Index], or [Search ] to search for the topic or term you are unsure about or have 
questions about.

[Contents] 

By clicking on one of the topics listed, you can find detailed information for that subject. 

[Index]

By selecting a Keyword in the Keyword list, and clicking the [Display] Button at the bottom, a 
detailed explanation will appear. 

[Search] 

Enter the keyword you wish to search for and click the [List Topics] Button. All topics that 
contain the keyword will be displayed. By selecting a topic and clicking the [Display] Button at 
the bottom, a detailed explanation will appear. 

- By clicking the help button in a dialog box, an explanation for that dialog box will appear

- In the Graph Window, by clicking on the  in the toolbar, you can have short explanations 
appear the next time you click on a menu, an icon, or anything in the main window. 
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■ Event Viewer Display Part Names and Functions
With Event Viewer you can view Recorded Event Time Data in a List (up to 64 channels), 
Print the List, or Save as Text File.

①
②

④

③

⑤

① Menu Bar 
Menus are lined up which contain various commands. They are used to view data or to make settings for 
the various functions in each menu.
↑ Icon: View only rising edge data This includes when there was a simultaneous occurrence of rising and 
falling.
↓ Icon: View only falling edge data.This includes when there was a simultaneous occurrence of rising and 
falling.
↑↓ Icon: View all Data 

② Toolbar 
Buttons appear for frequently used commands.

③ Button for Moving Vertical Axis 
Click the arrow buttons to move up or down.

④ Scroll Bar 
By dragging the Scroll Bar you can move up and down to the desired position.

⑤↑ / ↓ / ↑↓ 
View ↑ rising (Lo to Hi) waves, ↓ falling (Hi to Lo) waves, or ↑↓ both types.
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Changing the Event Viewer Method of Display 

■ Shifting Display: From the [View] Menu or the Toolbar
You can shift the display to view either by the recorded date / time or by the elapsed time 
from the last recorded data.

Recorded Date/
Time Display

Elapsed Time 
Display

■ Shifting Descending / Ascending: From the [View] Menu or the 
Toolbar

You can shift the display to view the recorded data either from the newest to the oldest or 
from the oldest to the newest.
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■ File Info: From the [View] Menu
View file info about data in the currently displayed data list.

File Name: File names of the data files currently displayed in the data list.

Path: The Location where the File is saved

Date Created: The date and time when the data file was created.

CH. Info: Channel No. / Recording Mode / No. of Data Readings
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Print Preview and Printing

Preview only that data which was selected and print. 

1. In the [File] Menu, select [Print Preview and Print]. 

2. In the [Select Channel for Printing] File list, select the channels you wish to print 
and click the [OK] Button.

[OK]
Button

3. The [Print Preview] will be displayed. After confirming, click the [Print] Button to 
start the printing.

Button Functions

[Print] :  The [Print] box will appear and printing will begin.

[Previous] :  Preview the previous page.

[Specify P] :  Specify the page you wish to preview in the [Specify Page to be Viewed] box and  
 a preview of that page will appear. 

[Next] :  Preview the next page.

[Reduce] :  Reduce the size of the displayed page.

[Enlarge] :  Enlarge the size of the displayed page.

[Close] :  Close the Print Preview Window and return to the Main Window.
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Saving Recorded Data

If you have edited any data that was displayed in a graph, we suggest that you save it as 
necessary.

3 Ways to Save Files
*In “Event Viewer” only [Save Data as…] can be used.

-In the [File] Menu, select [Overwrite All Data]

Will save any changes to file without changing File Name and Saving Location.
The same operation can be carried out from [Save] in the Toolbar.

-In the [File] Menu, select [Save All Data as...]
Save with a new File Name.

-In the [File] Menu, select [Save Displayed Data]
Save only that data in the current display. This is handy when you wish to save only the desired 
data.

EX: [Save All Data as...]

1. Click [Save All Data as...] in the [File] Menu.

2. Specify the [Location] and enter a [File Name].

3. Click [Save] to complete the saving process.

[Save]
Button

Assign a Location

Enter a File Name
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Creating Text File

By saving the recorded data as text file, you can create a file type that can be read by 
common spreadsheet software.

1. Click [Save in Text File] in the [File] Menu.

2. Select the [Text File Type] and [Range to be Saved], and click [OK].
- Comma, Tab, Space, and Semi-colon are codes used by common spreadsheet 

software, such as Excel
® and Lotus

®
, when reading Text File to divide cells.

[OK]
Button

Select the Range to be Saved

Select the
Delimiters

3. Designate the location to which the file should be saved and click [Save] to create 
and save the data as a Text File document.
-The extension for the created file will be [.txt].

[Save]
Button

Assign a Location

Enter a File Name

* Text File cannot be read into [Temp / Humidity Graph] or [Multi-scale Graph].
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For Event Viewer

1. In the [File] Menu, click [Save in Text File].

2. Select the [Text File Type], click [Designate File] Button and specify the saving 
location.

*Comma, Tab, Space, and Semi-colon are codes used by common spreadsheet 
software, such as Excel

®
 and Lotus

®
, when reading Text File to divide cells.

[OK]
Button

Select the Text File Type

[Designate File] 
Button

File Name and Location

3. Click the [OK] Button to finish the creation of the text file document. 
-The extension for the created file will be [.txt].

*[Event Viewer] cannot read text type files.
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Opening a Saved File

To open a previously saved file, designate the file name to open it.

1. Click [Open] in the [File] Menu of the Graph Display.

2. Select the name of the data you wish to open and click [Open] to view the data in 
graph form.

[Open]
Button

Select a data file to open

For Event Viewer

1. Open Event Viewer.

2. In the [File] Menu of the Event Viewer display select [Open File] and a list will 
appear. 

Select a data file to open

[Open]
Button
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*Using “RTR-5W for Windows” with Windows Vista or Windows 7
Note that, when using Windows Vista or Windows 7, if, as a normal User, “RTR-5W 
for Windows” was installed into the default folder [Program Files] the “Virtual Store” 
function may redirect and save files into separate folders for each User Account, as shown 
below:
[C:\User\(AccountName)\AppData\Local\VirtualStore\Program Files\(Application)].

(EX:
If login was carried out using the account name “myname” and “RTR-5W for 
Windows” is the application being run, the saving location will appear in the application 
window as: [C:\Program Files\RTR-5W for Windows\data] but due to the “Virtual Store” 
function the actual saving location will be [C:\User\myname\AppData\Local\VirtualStore\
Program Files\RTR-5W for Windows\data].
If the login was carried out from [Run as Administrator], the file will be saved to the folder 
as it appears in the application window. 
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Auto-Download Settings

Make settings here to automatically download data from the selected Remote Units at the 
specified time.

1. Open [RTR-5W for Windows].

2. Select the Remote Unit(s) you wish to make settings for, and in the [Registration / 
Administration] Menu click on [Remote Unit Properties].

*By right clicking on the selected Remote Unit icon(s), a popup menu will appear where 
you can select [Remote Unit Properties] to display the same window. 

3. Select to download [Every day at a fixed time] or [Fixed Interval] and make the 
appropriate settings. 

- Every day at fixed time (24 hour clock) 
Carry out the downloading of data automatically at a set time every day.

- Fixed Interval  
Carry out the downloading of recorded data automatically at a set interval of time. (Make 
setting for 10 days or less.) 

Make settings for the interval between 
downloads.

Make settings for the time of download.
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4. Assign a Data Storage Folder by clicking on the [Browse] button and selecting 
the desired folder.

Assign a Data Storage Folder.

*Using “RTR-5W for Windows” with Windows Vista or Windows 7

Note that when using the Windows Vista or  Windows 7 OS the “Virtual Store” 
function will redirect files from the default folder into which the program was installed 
to separate folders under [Program Files] for each user, as shown below: [C:\User\
(AccountName)\AppData\Local\VirtualStore\Program Files\(Application)].

(EX:

If login was carried out using the account name “myname” and “RTR-5W for 
Windows” is the application being run, the saving location will appear in the application 
window as: [C:\Program Files\RTR-5W for Windows\data] but due to the “Virtual 
Store” function the actual saving location will be [C:\User\myname\AppData\Local\
VirtualStore\Program Files\RTR-5W for Windows\data].

If the login was carried out from [Run as Administrator], the file will be saved to the 
folder as it appears in the application window.

5. Click the [OK] Button to finish the setting process.
NOTE:
- Make sure that RTR-5W for Windows is open when a programmed Auto-Download is scheduled to occur. 
- If another type of communication, such as a warning monitoring, occurs at the scheduled downloading time 

and downloading is not possible, downloading will begin upon the ending of the other communication. 
- Depending on radio wave conditions, data downloading may at times be impossible. Please check in the 

downloading log for important data.
- If the recording mode is set for One Time and the logger becomes full, you may be downloading the same 

data over and over again. 
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If you wish to Stop the Auto Downloading
Select the Remote Unit(s) for which you wish to stop downloading, under the Auto 
Downloading settings put a check next to [Not to be carried out], and click the [OK] Button. 

Programmed Auto Download: From [View] – [Programmed Auto 
Download]

If a Remote Unit is set for Auto Download, this will show the time of the next scheduled 
download. 
If another type of communication, such as a warning monitoring, occurs at the scheduled 
downloading time and downloading is not possible, downloading will begin upon the 
ending of the other communication. 

Viewing the Auto-Download Log: From [View] – [View Log]
Here, it is possible to view the date and time when Auto-Download settings were made, 
when an Auto-Download occurred, when settings were lifted and other communication 
results in a log form.
The logs are in CSV format which can be read by common spreadsheet software and 
saved as text file. 
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* Notes for Using Auto-download Function 

About the Auto-Download Function and Windows Automatic Update 

Windows can be set to use the Windows Automatic Update function. 
This will automatically periodically download and install patches, updates and important software 
repair programs in order to keep your computer up-to-date. 
If the default setting "Install Updates Automatically" is being used for Windows Update, depending 
on the downloaded program, Windows may automatically restart after downloading has been 
completed.  

Control Panel Windows Update Display 

(all displays are taken from Vista)

To solve this problem please take steps such as the following: 

1. Place a shortcut for “RTR-5W for Windows” in the “Startup” Folder of the 
“Start” Menu.
 By doing this,“RTR-5W for Windows” will be started when Windows is restarted, and 
if the programmed time for an Auto Download has passed, a message will be displayed 
asking whether or not you wish to run Auto Download, thereby putting the application in 
a waiting status for an entry from the user.
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2.  In the "Change Settings" display, we do not recommend that the setting be for 
other than "Install updates automatically (recommended)". 
Therefore we suggest the following to disable the Auto-restart of your computer system 
after an installation has occurred. 

Windows Update – Change Settings Display

* If in this display, the setting "Install updates automatically (recommended)" has been selected, 
installation and Auto-restart may occur without any confirmation necessary from the user.

3. After making settings for Windows Update in the "Group Policy Object Editor", 
select to not automatically restart the system after installation. 

Group Policy Object Editor Display

1.  Open the "Group Policy Object Editor". In the "Start Menu" under "Run…" enter [gpedit.msc] 
to open.

2.  Under "Computer Configuration" select "Administrative Templates" - "Windows Components" 
- "Windows Update" to open the Windows Update Tree. 

3.  Upon selecting "Windows Update" from the tree, a pane will appear to the right for settings, 
double click on "No auto-restart for scheduled Automatic Updates installed" to open the 
settings window. 
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4. Select "Enable" and click the [OK] Button or the [Apply] Button. By doing this the Auto-restart 
of the system will be stopped from occurring. 

5.  After finishing the settings, downloads and the installation of repair programs from Windows 
Update will occur automatically, but while being logged on, Auto-restart of the system will not 
occur. A message, as shown below, will appear asking for the user to restart the computer.
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Warning Monitoring

Warning Monitoring is carried by setting the upper and lower limit for each Remote Unit.

1. Open the [Network Settings Utility] and click on [Detailed Network Settings] to 
display a window where settings changes can be made.

2. Make settings for the "DNS Server Address" in [DNS Settings] and for the "SMTP 
Server Name" in [Warning Mail].

Enter the DNS server address Enter SMTP settings

3. Open [RTR-5W for Windows].

4. Select the Remote Unit(s) you wish to make settings for, and in the [Registration 
/Administration] Menu click on [Remote Unit Properties].
*By right clicking on the selected Remote Unit icon(s), a popup menu will appear where 
you can select [Remote Unit Properties] to display the same window. 

5. Check [When operating the warning function, monitor this Remote Unit], and 
enter values for the upper and lower limits. 

[OK]
Button

Enter Upper and 
Lower Limit Settings

6. Click the [OK] Button to finish the setting process.
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7. In the [Settings] Menu, click on [Start / Stop Warning]. 
*By right clicking on the selected Remote Unit icon(s), a popup menu will appear where 
you can select [Start / Stop Warning] to display the same window. 

[notification address]

[A sender address]

[Notification Settings]

[Warning Monitoring]

8. Make the desired settings.
Warning Monitoring

If you wish to carry out the monitoring of warnings, place a check next to the [Warning ON] 
and make monitoring interval settings.

*Enter an amount of time between 10 minutes and 1440 minutes. If this interval is short, 
battery life will be depleted quickly. 

Notification Address

Set the recipient address(es) for the Warning Mail.

*If the check is removed, the warning mail will not be sent to that address.

Sender Address

This will be only used in the mail display to show where a warning report mail has been sent 
from.
It should be noted that if you assign an imaginary address, in some cases the SMTP server 
will judge the mail to be SPAM or junk mail and not allow it to be sent. Please use your own 
mail address. 
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Notification Settings

-Amount of send rest time after sending warning report mail

Warning report mail will continue to be sent until the warning settings have been changed or 
the measured value falls back within the acceptable range, but it is possible to make settings 
here for a rest period to occur after a warning mail has been sent, so that they will not 
continually be sent. By entering 0, there will be no rest period.

-Notify of a communication failure for monitoring warnings

Place a check here if you wish to have communication failure reports sent to the recipient 
address(es). 

-Switch external output to ON when a warning occurs

Place a check here if you wish to have an alarm or warning lamp that is connected to the 
external output go on when a warning occurs.

9.  Click the [Set] Button to send the settings info to the RTR-5W and complete the 
settings.

[Setting]
Button

[Notification Test]
Button
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[Notification Test] Button
Use this to send a test mail from the RTR-5W to the notification address and confirm that 
the warning notification settings are correct. 
A notification test is successful if a notification test mail reaches the notification address. 
If it does not reach the set address, please check the SMTP server, Notification Address, 
and Sender Address settings. 
If you are sending mail via the Internet, it is necessary to first make sure that your 
network is properly connected to the Internet and you can send mail outside of your 
network. 
Depending on your operating environment, it may take some time before the mail is 
received. (Especially if the address is a cell phone address.)

Before carrying out a notification test, it is necessary to make settings for the 
following: 

- There must be a check next to Warning ON and proper entries must be made for "Notification 
Address" and "Sender Address".

- In the [Network Settings Utility], the SMTP server (mail server) must be assigned properly. (If 
you have questions, see the information provided by your provider). 

- It should be noted that if you assign an imaginary address, in some cases the SMTP server 
will judge the mail to be SPAM or junk mail and not allow it to be sent. Please use your own 
mail address. 

Viewing the Warning Log : From ([View] – [View Log])
In the warning log will appear all warning occurrences.
Due to timing problems, there may be instances when a warning cannot be stored into 
the computer. For details, see the Help for [RTR-5W for Windows].
The logs are in CSV format which can be read by common spreadsheet software and 
saved as text file. 
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Battery Life Warning Settings 

Make settings here to send a notification of low battery power via e-mail from the RTR-5W. 

1. Open RTR-5W for Windows.  

2. Click on [Remote Unit Battery Life Warning Settings] in the [Settings] Menu.  

3. Place a check next to [Send Warning E-mail from RTR-5W] and enter the Send 
Time, Sender Address and Recipient Address. Also, if you wish to use the 

same settings for all locations, put a check next to [Make same settings for all 
locations]. 

Check 

4. Click the [OK] button to send the settings to the RTR-5W and complete the settings.

5. Click the [Transmission Test] button to test if a mail can be sent.  

If warnings exist, send mail at this time: 
Make setting for the time of sending a battery life warning mail.  

Sender Address
Enter the address from which a battery life warning mail will be sent.  

NOTE:
Please enter a valid e-mail address via which the sending and receiving of e-mail can be performed. It should 
be noted that if you assign an invalid or an imaginary Sender Address, the mail may not reach the intended 

party.  

Recipient Address
Enter the address to which a battery life warning mail will be sent. Up to 3 e-mail addresses 
can be assigned. Please set an address to which it is possible to send a mail from the 
RTR-5W environment. 
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Mail Settings for Download 

NOTE:
If any changes have been made to the Remote Unit structure or settings, please make the settings again. 

1. Open RTR-5W for Windows. 

2. Specify the location, and in the [Settings] Menu click on [Mail Settings for 
Download]. 

3. Place a check next to "Send mail containing the downloaded data from this 
location" and make "Location Settings". 

Recorded Data Format (attachment) 
Select the format for the attached data file. 
For formats TRX, PV5, RP7: "TRX" can be opened by "Temp/Humid Graph", "PV5" can be 
opened by the "Multi-Scale Graph" and "RP7" can be opened by "Event Viewer" 
(These file formats are the same as the file formats which are created when downloading 
data using "RTR-5W for Windows".)
- Binary Format (for open format): By using this public format, users can create their own 
applications. 
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Subject Name (Title) 
Enter the title of the e-mail. Up to 16 characters can be entered. 

Sender Address 
Enter the address from which a mail containing the downloaded data will be sent. 

NOTE:
Please enter a valid e-mail address via which the sending and receiving of e-mail can be performed. It should 
be noted that if you assign an invalid or an imaginary Sender Address, the mail may not reach the intended 
party.  

Recipient Address
Enter the address to which mail containing the downloaded data will be sent. 
Please set an e-mail address to which it is possible to send a mail from the RTR-5W 
environment. 

4. Make "Remote Settings". 
Select a Remote Unit or Units for which you wish to make settings from the list and 
check "Send mail containing data from selected Remote". 

Select either "Send at Fixed Time Every Day" or "Send at Fixed Interval" and then set 
the number of hours for downloading data in the "Download data for this number of 
hours". 

5. After the settings have been completed, click "View these Settings". 
If you wish to make settings for other Remote Units, repeat the process as in steps 4 
and 5. 

6. Click the [OK] Button to send the settings to the RTR-5W and complete the 
settings.

7. Click the [Transmission Test] Button to test if a mail can be sent. 

[Gather Schedule] Button
This will retrieve download schedule info from the RTR-5W and display the time of the next 
scheduled download. 

NOTE:
New settings made here will not be transmitted to the RTR-5W and will not become activated until the [OK] 
Button has been clicked. 



118

RTR-52Pt Sensor Settings

The types of sensors that can be used with RTR-52Pt are either Pt100 or Pt1000. Select 
the type being used and make the necessary settings. 

*The settings can be made only via optical communication.

NOTE:
Note that if a recording session is in progress, it will be stopped during the sending of the settings.

1. Open [RTR-5W for Windows].

2. From the Administration Tree, select the RTR-52Pt unit (only one at a time) for 
which settings are to be made and then select [Settings] – [RTR-52Pt Settings].

[Send] 
Button

[Get Sensor Type] 
Button

Check one

3. Place a check next to [Pt100] or [Pt1000] and click the [Send] Button to send the 
settings and complete set-up.

[Get Sensor Type] Button 
The sensor settings for the RTR-52Pt unit currently placed on top of the RTR-5W will be 
gathered.
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Adjustment

Adjustment is a function used to make adjustments to Remote Unit measurements. By 
making adjustments to measurements, the adjusted measurements will be displayed and 
recorded. It is possible to select from two methods of adjustment: "1-point Adjustment" 
and "2-point Adjustment". Adjustment will be based upon the simple equation: Y=aX+b.(X 
equals the measured value and Y equals the value after adjustment.)）

The Adjustment Function can only be used with RTR-51/52/53/52PT, RVR-52A. 

NOTE:
- The settings can be made only via optical communication
- We cannot guarantee that after carrying out adjustment the measuring accuracy will improve for all 

measuring ranges.
- If you remove a sensor that was connected when adjustment was carried out and then connect a different 

sensor, make sure to make new adjustment settings to reflect the actual situation.
- By making new adjustment settings to an already adjusted device the new adjustment equation will be 

used to further adjust the previously adjusted result causing the difference to increase dramatically. Make 
sure to click the [Initialize] button before making any new adjustment settings on already adjusted values.

- When carrying out adjustments and formulating equations please take care with the settings and take 
personal responsibility for the process.

1. Open [RTR-5W for Windows].

2. From the Administration Tree, select the Remote Unit (only one at a time) for 
which settings are to be made and place it face down on top of the RTR-5W.

3. In the [Settings] Menu, select [Adjustment Settings (Optical Communication)].
NOTE (RVR-52A) :
- When measuring moisture with the RVR-52A, please make adjustment settings in [Settings] – [Moisture 

Probe Settings] – [Moisture Adjustment].Under [Moisture Adjustment], check "Make Adjustment" and 
enter the desired values. Click the [Use Adjustment in Equation] Button and the calculation equation will 
be displayed.
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4. Check the Method of Adjustment: [1 Point Adjustment] or [2 Point Adjustment] .
- 1-Point Adjustment: Use when measuring in a range of ± 20.

- 2-Point Adjustment: Use when measuring in a wide range.

[Initialize] Button

Check one

[Send Settings] 
Button

5. Enter the actual pre-adjusted reading(s) in the "Current Reading" box and the 
post-adjusted reference value(s) in the "Post-adjusted Reading" box.

For details see "Rough Guidelines for Adjustment".

6. Click the [Send Settings] button to send the adjustment equation to the Data 
Logger.5. Click on the [Send Settings] Button to send the adjustment equation to 
the selected Data Logger.

[Initialize] Button
Click this to clear the adjustment equation from the Remote Unit which is in communication 
with the PC and initialize the unit. 

Rough Guidelines for Adjustment

NOTE:
- The difference between the values entered for "Current Reading" and "Post-adjusted Reading" must be  
± 5 or less.

- Entries are valid to one decimal point.
- When using "2-Point Adjustment" if possible select two points apart from one another (we suggest at least 
10 degrees). 

- With "2-Point Adjustment" it is not possible to enter values that would result in the slope being 0 (zero).
- When using 2-Point Adjustment and measuring in a wide range make sure that the adjustment values 

reflect the wide range being measured.
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1-Point Adjustment: Use when measuring in a range of ±２０℃ .

This adjustment method changes only the offset (b) where the slope (a) is considered 1. 
For example, the Data Logger is measuring 10.2℃ , but the standard says the actual 
measurement should be 10℃ . Enter 10.2 in the "Current Reading" box and 10 in the "Post-
adjusted Reading" box. 
The conversion equation will be Y=X-0.2 and for all measurements an adjustment to the offset of 
-0.2 will be made.
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2-Point Adjustment: Use when measuring in a wide range.

The adjustment equation will be calculated from two points: the slope (a) and the offset (b). 
For example, the Remote Unit is measuring 0.2℃ and 10.4℃ , but the standard says the actual 
measurements should be 0℃ and 10℃ . Enter 0.2 and 10.4 in the "Current Reading" boxes and 
0 and 10 in the "Post-adjusted Reading" boxes.In this case the slope (a) is 10－ 0 / 10.4－ 0.2
＝ 0.98 
The conversion equation becomes Y ＝ 0.98X － 0.196 with the offset s 0.196. The range of the 
slope is 0<a<=2.Up to four digits are valid for the slope and offset.
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How to use the RTR-5W Web Viewer

■ Opening the RTR-5W Web Viewer

1. Open Internet Explorer.
*If you wish to use the Internet, make sure that the power for the router and computer 
are on so as to enable connection to the Internet. 

*Make settings to enable both Java applets and JavaScript. 

2. In the address area, enter the address of the RTR-5W logger you wish to view.

Enter Address

3. By pressing the [Enter] key, the RTR-5W Web Viewer will appear. 

【If the Viewer does not appear】

1. Make sure that the address you entered is correct.

2. Check to make sure that the IP address and subnet mask are set correctly and if 
necessary redo the [Detailed Network Settings]. 

3. Make sure that in [Location RTR-5W Properties] there is a check next to [Make 
access possible from a browser].



123

■ RTR-5W Web Viewer Functions
By opening the RTR-5W Web Viewer, the Monitor Current Readings display will 
automatically open. Also, it is possible to view the Data Transfer Graph for the current 
readings.

Monitor Current Readings

The RTR-5W displays the newest measurement readings that are collected at the regular interval 
set in [Location (RTR-5W) Properties].
By clicking the [Gather Current Readings] Button, communication will begin with the RTR-5W 
and the current readings will be displayed. 

Graph

The RTR-5W displays in simple graph form the newest measurement readings that are collected 
at the regular interval set in [Location (RTR-5W) Properties].
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Current Readings Monitor (accessing via browser)

View the current readings for all the Remote Units registered to a Location (RTR-5W). 

1. Open [RTR-5W for Windows] and make Data Gathering Interval settings.
- For details about how to make settings see part 4 [Browser Display Settings] of p.45 

[Remote Registration].

2. Open the Web Viewer for the RTR-5W of which you wish to view the current 
readings. 
- See p.122 for more details about the display. 

[Gather Current Readings]
Button

3. The Monitor Current Readings display will automatically open.

4. Click the [Gather Current Readings] Button to get the most recent info. 

*If the registration info is incorrect, go to RTR-5W for Windows [Settings] Menu – [Send 
Group / Remote Info] and send the correct registration info. 

■To view graphs in your browser, it is necessary to have Java Runtime Environment 
(JRE) installed on your computer.

If JRE is not already installed, please download and install it from the Sun Microsystems 
Website [http://www.java.com/en/]. 

NOTE:
The installation of JRE is completely the responsibility of the user.
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Graph (accessing via browser)

Via the browser, the readings measured by the Remote Unit(s) can be viewed in a simple 
Graph form

1. Open [RTR-5W for Windows] and make Data Gathering Interval settings.
- For details about how to make settings see part 4 [Browser Display Settings] of p.45 

[Remote Registration].

2. Open the Web Viewer for the RTR-5W of which you wish to view the Graph. 
- See p.122 for more details about the display. 

3. Click [Graph] and select the Remote Unit you wish to view; and the Graph will 
appear. 
- From [Monitor Current Readings], click the name of the Remote Unit you wish to view; 

and the Graph will appear.
- By clicking the [Show Graph] Button, the Graph will be refreshed. 

If any of the following operations are performed, all data in the graph will be erased. 

- If the communication function is restarted from the [Network Settings Utility]. 
- If the AC adaptor plug is removed. 
- If the clock settings are made from [RTR-5W for Windows].
- If the RTR-5W is rebooted from [RTR-5W for Windows].

■To view graphs in your browser, it is necessary to have Java Runtime Environment 
(JRE) installed on your computer.

If JRE is not already installed, please download and install it from the Sun Microsystems 
Website [http://www.java.com/en/]. 

NOTE:
The installation of JRE is completely the responsibility of the user. 
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Viewing Current Readings via Mobile Phone

View the current readings via a mobile phone browser for all the Remote Units registered 
to a Location (RTR-5W). 

1. Open the URL entry display and enter the URL for the RTR-5W logger you wish to 
view and press enter. 

2. Select the mobile phone carrier you wish to use.

3. The Current Readings display will automatically open.

NOTE :
- To view the current readings monitor via mobile phone, it is necessary to open the RTR-5W to the public 

on the Internet. 
- The current readings will not be automatically refreshed. You will have to use the browser refresh 

function on you cell phone. 
- For some types of mobile phones, it is forbidden to use any port number other than 80.
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Checking and Making Changes to Computer 
Network Settings

For some network environments, it may be necessary to make changes to the IP address 
and subnet mask at the computer side in order to carry out a search.
See the following procedures for checking and making changes to your computer network 
settings.

1. In the [Control Panel], open [Network Connections].

2. Select the Network adaptor that you are using, and right click with the mouse and 
open the Properties. 

3. Under the [General] Tab, in [This connection uses the following items:] select 
[Internet Protocol (TCP / IP) and lick on [Properties] Button. 

Check Internet Protocol 
(TCP / IP) [Properties]

Button
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4. In the [Internet Protocol (TCP / IP) Properties] window, under [Use the following 
IP address:] make sure that the IP address and Subnet Mask are correct.

Check to make sure that 
the "IP address" and 

"Subnet mask" are correct.

5. In order to return the settings back to the original ones make sure to write down 
the current settings for [IP Address], [Subnet Mask], [Default Gateway], [Primary 

DNS Server] and [Alternate DNS Server]. 

6. Enter "192.168.1.1" as the IP Address and "255.255.255.0" as the Subnet Mask. 

IP Address: 192.168.1.1 / Subnet Mask: 255.255.255.0

7. After entering, click the [OK] Button. 

8. Click the [OK] Button as seen in the 3 Properties window to close the window. 

9. Once again, in the [Network Settings Utility] run a search and check whether the 
IP address for the RTR-5W connected to the network is displayed. 



129

10 . If it is displayed properly, make the initial network settings. 

11 . After making the initial network settings, follow steps 1-4 above to open the 
[Internet Protocol (TCP / IP) Properties] window. Re-enter the [IP address], [Subnet 

mask], [Default Gateway], [Preferred DNS server], and [Alternate DNS server] that 

you had written down before and click the [OK] Button.

12 . Open the browser, enter the address (URL) that you set in the settings utility 
and check to make sure that the display is proper or not. 

*If you are using a company network or are working in an environment that may have 
special settings and after having followed the above procedures still cannot view the 
display properly, please connect your network administrator. 
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If USB Device Driver Installation Fails

If, during USB device driver installation, some trouble occurs that results in a failure to 
install properly, the following display will appear in the Device Manager.

   For Windows XP

If this occurs, the USB device driver must be re-installed.

■ How to Re-install
* The images in the following explanation are taken from [Windows XP].
They may differ from the windows that appear when using other Operating Systems.

1. In the [Control Panel], open [System].

2. In the System Properties Window, click the [Hardware] Tab, and then click the 
[Device Manager] Button in the [Device Manager] Area.

[Device Manager]
Button

[Hardware] Tab
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3. In the Device Manager Window, right click on [USB Device] under [Other Devices] 
and then click on [Properties] to display the [USB Device Properties] Window.

4. In the USB Device Properties Window, click on the [Re-install Driver] Button to 
display the Hardware Detection Wizard. Follow the directions to install.

[Re-install Driver]
Button
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Re-installing

Before reinstalling or updating the [RTR-5W for Windows] software, make sure to carry 
out the uninstall program first. Also, before uninstalling, make sure to quit all [RTR-5W for 
Windows] applications.

* To install [RTR-5W for Windows], it is necessary to have Administrator rights (Computer 
Administrator) for the computer in which you wish to install it. 

1. In the Windows Control Panel, click on [Add/Remove Programs].

2. From the list of currently installed programs, select [RTR-5W for Windows] and 
click the [Add / Remove] Button. 

3. The [Install Shield Wizard] will appear. Check [Remove], and click [Next].

Check [Remove]

[Next]
Button

4. Follow the directions to Uninstall.

5. After the uninstall process is completed, reinstall by following the directions to 
[Install].
- Even after uninstalling, saved data files will still remain in the folders and locations 

they were saved in.
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For Windows Vista / 7

1. In the [Control Panel], click [Program – Program Uninstall].

2. From the list of currently installed programs, select [RTR-5W for Windows] and 
click the [Uninstall] Button.

3. The [Install Shield Wizard] will appear. Check [Remove], and click [Next].

Check 

[Next]
Button

4. Follow the directions to Un-install.
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Troubleshooting

■ Network Settings Utility

Q.1 The following message appears "Windows Security Alert", what should 
I do? 

A If you are using Windows XP SP2, the following message may be displayed.

There is no problem, so please click [Unblock].

Q.2 Is it possible to use the [Network Settings Utility] via a proxy server? 

A Communication is impossible via a proxy server. With Web Viewer communication is 
possible. 

Q.3 I cannot run a search in the Network Initialization. Why?

A One of the following may be the reason:
Power is not being supplied by the AC adaptor to the RTR-5W.
The RTR-5W and the computer you are using are not on the same network.
The [Network Settings Utility] is already being used by another computer.
The LAN card which is being used has not been formatted.

Q.4 I cannot make settings in the Network Initialization, Why?

A One of the following may be the reason.
- The Login ID and / or Password are incorrect.
- Another RTR-5W with the same IP address is on the same network.

Q.5 Why does a "Communication Error (Connection Error) " appear?

A The network is probably not properly connected.
- One of the following is incorrect: IP address or Domain, Login ID, Password, or Port 
Number.

- The network is not properly connected (the LAN cable is broken, the Hub is damaged, a 
mistake occurred in setting up the router, etc.).

- In the "Menu"-" Communication Time Settings" try slowing the communication time.
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Q.6 Because of some other [Communication Error] communication cannot 
occur. Why?

A One of the following may be the reason:
- The IP Block setting is ON and communication can occur with only specific PC's.
- If after several attempts a communication error continues to occur, turn OFF the RTR-
5W and restart.

- A warning report mail or test mail may be in process. If a sending error occurs, 
processing takes time, so please wait for at least one minute before trying again.

Q.7 Which has priority, a wireless LAN or a wired LAN?

A If a wireless LAN card is inserted, the wireless LAN will have priority. Because of this, if 
the wireless LAN settings are incorrect and a wired LAN is connected, communication will 
not take place via the wired LAN and hence communication will not occur.

Q.8 I forgot the password, what should I do?

A First, return the settings to the factory default settings and then redo the settings.

Q.9 Is it possible to hide the IP address history and settings history?

A If you wish to disable the History, in the "Menu", select [Login History] and click to "OFF".
Please note that a history will remain viewable from when before it was disabled. To erase 
a history, please click on "Clear Login History" in the Menu.
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Q&A about RTR-5W

■ Q&A about RTR-5W

Q.1 RTR-5W units use an AC adaptor, what happens when there is power 
shortage?

A - During a power shortage the Web Server will not function and communication via LAN 
cannot occur.

- If SNTP settings have not been made, the clock will be reset. 
- The data files for transfer will be erased.
- All warning occurrence logs stored in the RTR-5W will be erased.

Q.2 Can I connect directly to my computer with the LAN cable that comes 
with the logger?

A To connect a RTR-5W logger directly to your computer, you must use a cross LAN cable.
The LAN cable supplied is a straight LAN cable and cannot be used to connect directly to 
your computer.
Please purchase a cross LAN cable at your local computer supply store.

Q.3 Does the RTR-5W have a clock and calendar?

A The RTR-5W has an internal clock (calendar) built into it.
If the internal clock settings for the RTR-5W are not set correctly, the date and time in 
the RTR-5W Web Viewer’s current readings monitor and the time of warnings will also be 
incorrect. Make sure to set correctly before using.

NOTE:
If you make clock settings manually, the clock will lose its settings upon removal of the AC adaptor 
or after restarting the system.

Q.4 Is it possible to connect the RTR-5W to the network by using the LAN 
cable that connects the computer to the LAN network?

A Inserting the wireless LAN cable that connects the computer to the network into the RTR-
5W will physically connect the RTR-5W to the network, but without making the necessary 
settings such as IP address, the RTR-5W cannot be active in the network and hence is not 
really connected. 
After having inserted the LAN cable, make sure to go to [Network Settings Utility] to make 
the necessary IP address and subnet mask settings. 

Q.5 Is it possible to connect to a wireless LAN by removing the wireless 
LAN card from my computer and using it?

A It is necessary to make Wireless LAN settings.
In [Network Settings Utility], under [Detailed Network Settings] make changes to the 
[Wireless LAN Settings]. After that, turn OFF the RTR-5W power, then insert the card and 
turn the power back ON.
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Q.6 I want to use a wireless LAN; which products can I use? 

A Currently, the only Wireless LAN card which has been tested and proven compatible with 
the RTR-5W is the Dark Marketing Corporation’s Wireless LAN card “XI-815”.
Unfortunately, the production and sales of this card have been discontinued.If you already 
have this Wireless LAN card please use as directed.

Q.7 Which has priority, a wireless LAN or a wired LAN?

A If the Wireless LAN is connected properly and all settings are correct, the Wireless LAN will 
have priority.

Q.8 I want to have a mail sent when a warning occurs, how can I do this?

A To use the warning mail function, it is necessary to have an SMTP server.
If you have an Internet connection, use the mail server of your Internet service provider or 
some other means to access a mail sever. If you have a mail server on your company LAN, 
there may be specific instructions and settings for sending mail. Please ask the network 
administrator at your company for details.
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■ Q&A about Web Server Functions

Q.1 Are the RTR-5W Base Stations web servers?

A The RTR-5W stations have web server functionality built into them. This function allows 
for the provision or serving up of temperature and humidity data, current readings and 
graphs. 

Q.2 What is a Web Server? What is a client?

A In a computer network, the computer that acts as a provider of services to various users 
is called a server and the computers which request these services from the server are 
referred to as clients. 
Most communication service is made up of exchanges between servers and clients.
In the case of RTR-5W, the RTR-5W provides functions and information so it is a server 
and the computer, which reads this information or functions, is the client. 
For example, the storage of Website and the making public of these are done by the [Web 
Server] and the sending and receiving of e–mail is performed by the [Mail Server].

■ Q&A about Viewing the Web Site

Q.1 Can I use a RTR-5W logger without connecting it to a network?

A If the RTR-5W is not connected to a network, the downloading of recorded data, the 
display of current readings, recording settings and all other types of settings cannot be 
carried out. 

Q.2 What must I do to view current RTR-5W readings on my cell phone? 

A To view the current readings of a RTR-5W it is necessary to connect your cell phone to the 
Internet. 
If the RTR-5W is connected to the Internet it is possible to view the current readings via 
your cell phone by entering the same URL as you do when viewing via your computer. 
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■ Q&A about Networks

Q.1 What is a network?

A A network is a system in which a group of computers are connected by cable (copper wire, 
optical fiber, etc), infrared ray, radio waves or other means in order to share and exchange 
information.
There are basically two types of computer networks.
A Local Area Network or LAN consists of a group or network of computers in a limited 
range.
A Wide Area Network or WAN is a network of computers that are connected over long 
distance. The Internet is an example of a WAN that has connected a multiple number of 
networks. 

Q.2 What is an IP address? 

A In a network, in order to distinguish your computer from another it is necessary to assign a 
number; this number is called an IP address.
When you connect to an outside network such as the Internet the IP address that is used is 
referred to as a "Global IP address. In a Local Area Network the IP address that is used is 
called a "Private IP address".
An IP address is divided into 4 blocks of numbers separated by periods, such as 
"192.168.15.10". The assigned numbers can use the digits 0-255 with private IP addresses 
usually beginning with numbers such as "192.168.".
※ However, the number "255." is not usually used.
This number is absolutely necessary to enable participation in a network, so it is necessary 
to set the IP address to a number that suits your network environment.

Q.3 What is a Subnet mask?

A An IP address is made up of the network address to which the computer belongs (network 
address) and the computer’s own address within the network (host address). The Subnet 
mask determines the division between these.
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The Subnet mask, similar to the IP address, is made up of four blocks of numbers divided 
by periods, such as "255.255.255.0".
This number is absolutely necessary to enable participation in a network, so it is necessary 
to set the Subnet mask to a number that suits your network environment.



140

Q.4 How should I make settings for the IP address / Subnet mask?

A The IP address and Subnet mask settings vary depending upon your networking 
environment (structure). Please consult your network administrator for details. Below is a 
simplified explanation of a company LAN set up for your reference.
If the computer connected to your company LAN has a Subnet mask of "255.255.255.0" 
and an IP address of "192.168.100.1", set the Subnet mask to the same as your computer, 
"255.255.255.0".
Set the IP address to 192.168.100.***. Make sure to set the last three digits,***, to a number 
between 1-254 that is not the same as any other computer connected in your network.
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Q.5 What is a MAC address?

A A MAC address is a unique number made up of alphabet and numbers that is assigned 
separately to the components of network communication (computer, server, router, etc.). 
Each MAC address is assigned to the hardware and is unique to that device, so there is no 
chance for duplication.

Q.6 What is a port number?

A When using TCP/IP communication with a LAN cable or via a phone line, port numbers are 
assigned to distinguish one application from another.
Port numbers can be assigned from 0 to 65535. The numbers 0 to 1023 are already 
reserved to communication services and are referred to as "Well Known Port Numbers".
[Well known port numbers] are: HTTP communication at 80 / FTP communication at 20 and 
21 / SMTP communication (sending mail) at 25 / POP3 communication (receiving mail) at 
110.
In order for communication to work properly these port numbers must be set correctly.

Q.7 What is a gateway?

A A gateway is a term used to refer to a device or software that is used to link networks with 
different standards.
For example, a gateway is needed when connecting a cell phone to the Internet or in any 
case where you wish to connect two devices that are completely different. Gateway carries 
with it the meaning of entrance and exit and a router may also be referred to with this term.
When making gateway settings, it is necessary to make IP address settings for the device 
that will act as a gateway.



141

Q.8 What is a URL?

A A URL is an address that is written in a way so that it is easy for the DNS function to 
determine on which server the IP address is located.
This address begins with "http:// " and is followed by such things as domain names, server 
names, port numbers, file names and other such info.
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For example, if the IP address that is assigned to "www.tandd.com" is "61.197.203.107", 
by entering "http://61.197.203.107/product/wdr_3/tr_7w_01feature.html" in the browser, 
the same page will appear as when you enter "http://www.tandd.com/product/tr_7w/
tr_7w_01feature.html".

*The DNS or Domain Name Server helps to switch difficult to understand IP address of just 
numbers, such as "61.197.203.107" into easy to grasp names such as "www.tandd.com" 
and helps connect to the desired server.
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■ Q&A about the Internet

Q.1 What is a fixed IP address?

A Usually, when you connect to the Internet, the provider with which you have contracted 
service automatically assigns an IP address which may be different each time you connect, 
or may change after a certain length of time. 
With this type of changing IP address, it is more difficult for outsiders to illegally enter your 
computer. On the other hand, when using your computer or a RTR-5W unit as a sever, 
it would be necessary to enter a different IP address as the URL each time you wish to 
access it. In such a case, it would be necessary to find out the current IP address each time 
you wished to access and this would be totally inconvenient. 
To help solve this problem, there is something called a fixed IP address service that your 
provider can offer. 
With a fixed IP address, you will be assigned a special unique IP address. 
Some providers may give you a fixed IP address from the beginning of service, but with 
most providers it is necessary to sign up for this special service.

Q.2 How do you get a fixed IP address?

A A fixed IP address is a service offered by your Internet provider. 
For details about how to receive a fixed IP address, contact the Internet provider with which 
you are connected. 

Q.3 How should I set up a fixed IP address?

A If you are using only one RTR-5W connected to one router, then the fixed IP address should 
not be set for the RTR-5W, but for the router. If you are using a multiple number of RTR-
5W connected to one router, the RTR-5W will use FTP and HTTP so, please set a fixed IP 
address for each RTR-5W unit. 
Because it is impossible, when using normal ADSL or FTTH lines, to directly connect the 
RTR-5W to the Internet line, it is necessary to place a router between the logger and the 
ADSL (FTTH) modem. 
When using a router, the fixed Internet IP address should be assigned to the router and 
all access to the RTR-5W from outside should go through the router. In this case, the 
router will have two IP addresses: an external IP address for the Internet and an internal IP 
address for the company or household LAN. 
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Q.4 I want to use a URL without a fixed IP address, how can I do that? 

A If you wish to access an RTR-5W by URL but without a fixed IP address, it is possible to 
use a dynamic DNS.
The DNS or Domain Name Server helps to switch difficult to understand IP address of just 
numbers, such as "61.197.203.107" into easy to grasp names such as "www.tandd.co.jp" 
and helps connect to the desired server. 
The DNS usually changes names to fixed IP addresses. 
But, if for some reason you cannot use a fixed IP address or for security reasons you wish 
not to use a fixed IP address, there is a type of DNS called a dynamic DNS, which can 
handle ever-changing IP addresses. 
For example, the starting IP address is "210.0.0.1" and the URL associated with it is "http://
www.rtr5w.com".
The IP address "210.0.0.1" is of the changing type that is periodically reassigned by the 
provider. After a certain period of time the assigned IP address is changed to "210.0.0.2".
Normally, at this point the DNS would not associate the URL with the IP address and 
access would be made impossible, but because the dynamic DNS tracks the IP address 
you can still access the desired server using the same URL. 
There are many types of dynamic DNS plans and services available, please contact your 
local provider for more details. 

Q.5 Can I use the Warning Mail function without getting or using a fixed IP 
address?

A If it is possible for you to connect to the Internet by using a dynamic DNS, theoretically it 
is possible to send mail without having or using a fixed IP address. That is presuming it is 
possible to successfully send data via your provider's mail sever or your company's mail 
server. 
Fundamentally, if you are able to access your company mail server or connect to the 
Internet it should be possible to send mail. 

Q.6 Is it possible to connect to the Internet without a fixed IP address or an 
URL?

A Yes it is possible to connect without using a URL or having a fixed IP address, but because 
the IP address that will be assigned by the provider will be constantly changing, the access 
will be varied and will not go smoothly.
For example, the IP address that you used successfully one hour before may no longer 
work and access will be made impossible. Further, you will have no way of verifying the new 
IP address.
We strongly suggest using either a fixed IP address or a dynamic DNS.
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Q.7 If I connect the RTR-5W to the Internet, is it not possible that another 
person could read my data or change my settings?

A Yes, as long as you are connected to the Internet, the logger could well be the target of 
unwanted access. 
And, as long as you are open on the Internet, it is possible that a third party could view your 
current readings or recorded data, or even, make changes to your settings. 
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Specifications

■ Web Wing WL RTR-5W
Compatible devices RTR-51, RTR-52, RTR-52Pt, RTR-53, RVR-52A, RTR-50

Operational Status 
Display 

LED Lamp Display ( Power ON / Wireless Communication in Progress / Warning Occurrence)

Power Specific AC Adaptor

Communication Method Wired LAN: 100 BASE-TX / 10BASE-T (RJ45 Connector)
Wireless LAN: IEEE802.11b (CF Wireless LAN Card) *1

Communication Speed Special short wave radio wireless: 2000 readings per minute 
Optical Communication: 2400bps

Communication Time When downloading data from Data Logger with RTR-5W via wireless communication (1 unit 
of full data takes about 420 seconds)

External 
Output(Warning Output)

When operating the warning functionVoltage when OFF: AC/DC less than 50V / Current when 
ON: less than 0.1A / ON Resistance: MAX 35Ω

Dimensions / Weight of 
Main Unit

H83× W102× D28 mm (excluding protrusions) / abuot 137g

Operating Environment Temperature: 0 to 50ºC / Humidity: 20 to 80％ RH (without condensation)

Accessories included in 
package

AC Adaptor AD-0606 x 1 / LAN Cable LN-20W x 1
Software Set / Introductory Manual and Warranty x 1

*1  For information and updates concerning which wireless LAN cards can be used, please contact your local T&D dealer or representative.

■ PC Operating Environment
OS
PC/CPU
Memory
Hard Disk
Monitor
LAN

Browser

Microsoft Windows® 7 32/64bit, Windows Vista® 32bit , Windows XP 32bit  english　*1
A Stable Windows Operating Environment
Enough memory to stably operate Windows
More than 10 MB of free space (Data will need more space)
SVGA (higher than 800× 600 recommended)・more than 256 colors
100BASE-TX or 10BASE-T
Twisted pair cable confirming to Category 5 (STP/UTP)
Internet Explorer 6.0 or higher 

*1  For installation, it is necessary to have Administrator (Computer Administrator) rights. 

■ RTR-5W for Windows

RTR-5W for Windows

Compatible 
devices

RTR-5W

Functions Remote Unit Registration, Recording Start / Stop, Download Data, Auto-Download Settings, Warning 
Report Settings, Gather Current Data, Data Transfer, View Remote Unit Battery Level / Adjustment

Network Settings Utility

Compatible 
devices

RTR-5W

Functions Network Initialization Settings, Detailed Network Settings.
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Temp / Humidity Graph

Compatible devices RTR-5 Series, TR-71W / TR-72W, TR-7 Series, TR-5 Series, RTR-7 Series Data Loggers

Number of Channels 8 Channels Simultaneous Display / Processing

[Screen Display]

Graph 

Data 
 

Other Functions

Temperature / Humidity Graphs for every Channel (Zoom in/out and scroll with mouse or 
keyboard), Change Display Colors for Channels, View/ Hide Channels

Channel Name, Recording Interval, Number of Data, Highest, Lowest and Average, Unit of 
Measurement,  A and B Cursor Dates/Times and Temp/Humidity Readings, Calculated Temp / 
Humidity Difference between Cursor A and B

Data List Display, Calculation Range (Time Period) Settings, Data Maintenance, Delete Data by 
Channel, Re-order Data by Channel, Vertical Scale Settings

File Output Special T&D Data File・Text File (CSV, etc)

Printing Graphs / Tables

Multi-scale Graph

Compatible devices RTR-5 Series, RVR-52A, TR-7W Series, TR-7 Series, TR-5 Series, RTR-7 Series Data Loggers

Number of Channels 8 Channels Simultaneous Display / Processing

[Screen Display]

Graph 

Data 
 

Other Functions

Data Graphs for every Channel (Zoom in/out and scroll with mouse or keyboard), Change 
Display Colors for Channels, View/ Hide Channels

Channel Name, Recording Interval, Number of Data, Highest, Lowest and Average, Unit of 
Measurement, A and B Cursor Dates/Times and Measurements, Calculated Differences in 
Measurements between Cursor A and B

Data List Display, Calculation Range (Time Period) Settings, Data Maintenance, Delete Data by 
Channel, Re-order Data by Channel, Vertical Scale Settings

File Output Special T&D Data File・Text File (CSV, etc)

Printing Graphs / Tables

Event Viewer

Compatible devices RVR-52A (for Recorded Event Time Data)

Number of Channels 64 Channels Simultaneous Display / Processing

[Screen Display]

Data List 

Other Functions

View Event Time Data List for Each Channel (Zoom in/out and scroll with mouse or keyboard), 
View Rising (Lo to Hi) Waves and Falling (Hi to Lo) Waves

Shift between Descending/Ascending

File Output Special T&D Data File・Text File (CSV, etc)

Printing Print Data List

■ About the RTR-5W Web Viewer
Compatible devices RTR-5W

Functions Monitor Current Readings, View Graphs
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Options

AC adaptor (for RTR-5W)
AD-0605 AC adaptor
AC 100 to 120V
Cable Length : 74in (1.85 m)

Wall Attachment Unit (for RTR-5W)
TR-5WK1 Wall Attachment
Double-sided Adhesive Tape x 1

Materials : Polycarbonate
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Temperature Sensors (For TR-52/RTR-52)                             unit: millimeters

TR-5106  Fluoropolymer Coated Sensor
Cable Length :
Thermal Time 
Constant : 

24in (0.6 m)
Approx. 15 Sec. (in air)
Approx. 2 Sec. (in agitated water)

TR-5101  Fluoropolymer Coated Sensor
Cable Length :
Thermal Time 
Constant :  

1.8in (45 mm)
Approx. 15 Sec. (in air)
Approx. 2 Sec. (in agitated water)

TR-5220  Stainless Protection Sensor
Cable Length :
Thermal Time 
Constant : 

80in (2.0 m)
Approx. 36 Sec. (in air)
Approx. 7 Sec. (in agitated water)

TR-5320  Stainless Protection Sensor
Cable Length :
Thermal Time 
Constant :  

80in (2.0 m)
Approx. 12 Sec. (in air)
Approx. 2 Sec. (in agitated water)

TR-5420  Stainless Protection Sensor
Cable Length :
Thermal Time 
Constant :  

80in (2.0 m)
Approx. 12 Sec. (in air)
Approx. 2 Sec. (in agitated water)

Materials : ① Thermistor   ② Stainless pipe (SUS316)   ③ Fluolymer Compaction Tube ④ Fluoropolymer-Coated 

                                             ical Wire

Possible Measurement Range :

Sensor Temperature Durability :

Measurement Accuracy : 

Waterproof Capacity :

-60 to 155ºC

-70 to 180ºC

Average ± 0.3ºC(-20 to 80ºC)　Average ± 0.5ºC(-40 to -20ºC/ 80 to 110ºC) 
Average ± 1.0ºC(-60 to -40ºC/110 to 155ºC)

The Fluoropolymer-Coated Section is Waterproof, Stainless Protection Tube is 
Submersible, Other Sections are Immersion-proof.

TR-5530  Underwater Sensor
Cable Length:
Thermal Time: 

2.0m
Constant
Approx. 120 Sec. (in air)
Approx. 60 Sec. (in agitated water)

Materials : Thermistor   Fluoropolymer-Coated  Electrical Wire    Fluoropolymer Mold                                             
                                                                                                      

Possible Measurement Range:

Sensor Temperature Durability:

Measurement Accuracy: 

Waterproof  Capacity:

-60 to 155ºC

-70 to 180ºC

Average ± 0.3ºC(-20 to 80ºC)　Average ± 0.5ºC(-40 to -20ºC/ 80 to 110ºC) 
Average ± 1.0ºC(-60 to -40ºC/110 to 155ºC)

Sensor and Cable are submersible.
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Temp / Humidity Sensor (For RTR-53)                                   unit: millimeters

TR-3310  Temp / Humidity Sensor
Cable Length :40in (1 m)

Materials : ① Temperature/Humidity sensor 　② Polypropylene resin 　③ Vinyl Coated Electrical Wire 

Possible Humidity Measurement Range :

PossibleTemperature Measurement Range:

Sensor Temperature Durability :

Humidity Measurement Accuracy :

Service Life :

Operational conditions :

10 to 95％ RH

0 to 50ºC

-10 to 60ºC

± 5％ RH (at 25ºC 50％ RH)

1 year (under normal operational conditions)

Without dew condensation, water leakage or effect from corrosive gas or 
organic solvents.

Input Cables (For RVR-52A)　　　 　　　　　　  　　　     unit: millimeters

RPR-7101 Pulse Input Cable
Cable Length :60in (1.5 m)

RVR-5203 4-20mA Probe Cable
Cable Length :60in (1.5 m)

Materials : ① M3.5 Crimp Terminal　② Vinyl Coated Electrical Wire
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Sensor Adaptor (For RTR-52Pt)                                                   unit: millimeters

RTR-05P1　
Cable Length :
Operational 
Temperature :

40in (1.0 m)
-25 to 60ºC

※ Not Waterproof. Materials : ① Vinyl Chloride　② Vinyl Coated Electrical Wire

Sensor Extension Cables (For RTR-52/RVR-52A)                 unit: millimeters

TR-2C30 Sensor Extension Cable
Cable Length :
Operational 
Temperature :
Waterproof 
Capacity :

120in (3.0 m)
-25 to 60ºC

Splash-proof 
 (for use in daily life)

NOTE:
Only one cable per sensor.
When using the extension cable there will be a +0.3ºC at normal temperature and at -50ºC a gap of 
+0.5ºC may occur.

VR-2C10 Sensor Extension Cable (to Moisture Sensors)
Cable Length :40in (1.0 m)

Materials : ① Vinyl Coated Electrical Wire
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Power (For RTR-5/RVR-5)                                                        unit: millimeters

RTR-05A1 External Power Adaptor
Voltage Input:

Back-up Power:

Back-up Time:

Charging Method:

Operating 
Temperature:

Waterproof Capacity:

Weight :

Kit Contents:

DC6V

Ni-MH Battery (In case of power loss)

4 days (*1)

Trickle Charge

0 to 60ºC 

None

about 37g (without AC Adaptor)

Attachment hook x 1

Rubber Packing x 1 (for back of main unit)

Rubber Packing (small) x 1 (for AC Adaptor jack)

Silica Gel Pack (drying agent) x 1

Double-sided Adhesive Tape x 1 
(for fastening Silica Gel)

Screws x 2 
(extras for fastening back of main unit)

* When using RTR-05A1, it is necessary to purchase AC-Adaptor.
For details, contact your local representative or dealer.

RTR-05B1  Large Capacity Battery Pack
Power:

Battery Life: 

Waterproof 
Capacity:

Operating 
Temperature:

Weight:

Contents:

Lithium Battery x 1 (LS26500)

about 2 years and 6 months (*1) 

(Monitoring at 1 minute interval = about 20 
months)

Splash - proof

 
-40 to 80ºC (*2) 

about 75g (including lithium battery)

Attachment hook x 1

Rubber Packing x 1 (for back of main unit)

Silica Gel Pack (drying agent) x 1

Double-sided Adhesive Tape x 1  
(for fastening silica gel)

Screws x 2 
(extras for fastening back of main unit)

(*1) : Battery Life varies depending on measuring environment, recording interval, transmission frequency, and 
ambient temperature. Specifications and explanations used in this User's Manual are based on operations carried out 
with a new battery and are in no way a guarantee of your actual battery life.

(*2): Operating temperature depends on the specifications for the data logger being used. 
When using RTR-05B1, it is necessary to purchase Lithium Battery (LS26500). For details, contact your local 
representative or dealer.
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Power (For TR-5/RTR-5/RVR-5)                                                 unit: millimeters

TR-00P1 Maintenance Set　
Contents: Rubber Packing x 1 (for back of main unit)

Silica Gel Pack (drying agent) x 1
Double-sided Adhesive Tape x 1 
(for fastening silica gel)
Screws x 2 
(extras for fastening back of main unit)

TR-11P2 Low-Temperature Battery Set
Contents: Lithium Battery x 1 (LS14250)

Tube x 1 
Maintenance set x 1 (TR-00P1)
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Wall Attachment (For TR-5/RTR-5/RVR-5)                               unit: millimeters

TR-05K3 Wall Attachment
Operating Temperature:
Contents:

Compatible devices：

-40ºC to 80ºC
Double-sided Adhesive Tape x 1  
Screws x 2
RTR-5/RVR-52A/TR-5

NOTE:
If a strong shock occurs to the unit in environments under 
-30ºC, cracking may occur.

Materials : ① Polycarbonate

TR-05K3L Wall Attachment
Operating Temperature:
Contents:

Compatible devices：

-40ºC to 80ºC
Double-sided Adhesive Tape x 1  
Screws x 2
For use with Data Loggers  
RTR-5L / RVR-52AL or  
RTR-5 / RVR-52A in conjunction 
with RTR-05A1 Adaptor or RTR-
05B1 Battery Pack

NOTE:
If a strong shock occurs to the unit in environments under 
-30ºC, cracking may occur.

Materials : ① Polycarbonate



For product information or questions contact us at:   

Shimadachi 817-1, Matsumoto, Nagano 390-0852 JAPAN
Tel: +81-263-40-0131     Fax: +81-263-40-3152
E-mail: support@tandd.com
Office Hours: Monday to Friday 9:00-12:00/13:00-17:00 (GMT +9:00 Tokyo Time)

Website

http://www.tandd.com/
We have opened an English Website for your convenience. Here you can find information about our 
company, news, products, upcoming events, software and user's manual downloads, as well as, 
other support. Please stop by and see what we have to offer.

Web Wing WL  RTR-5W
User's Manual
Published by T&D Corporation (US / 9 th Edition)
© Copyright  T&D Corporation.   All rights reserved.
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